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1 • Introduction

1.1 Introduction to Ion Chromatography (IC)

NOTE Appendix E contains a glossary of chromatography
terms. 

The Dionex ICS-90 Ion Chromatography System (ICS-90) performs isocratic ion 
analyses using suppressed conductivity detection. An ion chromatography system 
typically consists of a liquid eluent, a high-pressure pump, a sample injector, a 
separator column, a chemical suppressor, and a conductivity cell. Before running 
a sample, the ICS-90 is calibrated using a standard solution. By comparing the 
data obtained from a sample to that obtained from the standard, sample ions can 
be identified and quantitated. A computer running chromatography software 
automatically converts each peak in a chromatogram to a sample concentration 
and produces a tabulated printout of the results. 

The IC analysis consists of four stages (see Figure 1-1):

1. Eluent Delivery 

• Eluent, a liquid that helps to separate the sample ions, carries the 
sample through the ion chromatography system. The ICS-90 is an 
isocratic delivery system. This means that the eluent composition and 
concentration remain constant throughout the run. 

• Liquid sample is injected into the eluent stream either manually or 
automatically (if an automated sampler is installed).

• The pump forces the eluent and sample through a separator column (a 
chemically-inert tube packed with a polymeric resin). 

2. Separation

• As the eluent and sample are pumped through the separator column, 
the sample ions are separated. In the ICS-90, the mode of separation 
is called ion exchange and it is based on the premise that different 
sample ions migrate through the IC column at different rates, 
depending upon their interactions with the ion exchange sites.
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3. Detection

• After the eluent and sample ions leave the column, they flow through 
a suppressor that selectively enhances detection of the sample ions 
while suppressing the conductivity of the eluent.

• A conductivity cell monitors and measures the electrical conductance 
of the sample ions as they emerge from the suppressor and produces a 
signal based on a chemical or physical property of the analyte.

4. Data Analysis

• The conductivity cell transmits the signal to a computer running 
chromatography software.

• The chromatography software (for the ICS-90, this is Chromeleon®) 
analyzes the data by comparing the sample peaks in a chromatogram 
to those produced from a standard solution. The software identifies 
the ions based on retention time, and quantifies each analyte by 
integrating the peak area or peak height. The results are displayed as a 
chromatogram, with the concentrations of ionic analytes 
automatically determined and tabulated.

Figure 1-1.  Ion Analysis Process
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1.2 Overview of the ICS-90

In all major respects, the ICS-90 operating process is similar to the overview of 
ion analysis described in Section 1.1. The ICS-90 is an integrated ion 
chromatography system containing a pump, injection valve, and conductivity cell. 
Other system components, including a guard column, separator column, and 
suppressor, must be ordered separately. These components vary, depending on the 
analyses to be performed. System components are described and illustrated in 
Section 2.1.3. 

ICS-90 operation is controlled remotely by a personal computer running 
Windows® 2000 and Chromeleon software (version 6.40 or later). Chromeleon is 
used for instrument control, data acquisition, and data processing.

For communication between the ICS-90 and Chromeleon, the ICS-90 must be 
connected to a USB (Universal Serial Bus) port on the computer or a USB hub. 
For installation instructions, see Appendix B and also refer to Installing the 
Chromeleon IC System (Document No. 031883).
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1.3 About This Manual

Chapter 1
Introduction

Introduces ion analysis, gives an overview of the ICS-90, and 
explains the conventions used in this manual, including 
safety-related information.

Chapter 2
Description

Describes ICS-90 operating features and the chromatographic 
flow path.

Chapter 3
Operation and 
Maintenance

Provides operating instructions, introduces the Chromeleon 
user interface, and describes routine preventive maintenance 
procedures.

Chapter 4
Troubleshooting

Lists problems and presents step-by-step procedures for how 
to isolate and eliminate the cause of each problem.

Chapter 5
Service

Provides step-by-step instructions for routine service and 
parts replacement procedures.

Appendix A
Specifications

Lists the ICS-90 specifications and installation site 
requirements.

Appendix B
Installation

Describes how to install the ICS-90.

Appendix C
Reordering 
Information

Lists spare parts for the ICS-90.

Appendix D
FAQ

Provides answers to frequently asked questions about ICS-90 
operation.

Appendix E
Glossary

Defines terms commonly used in ion analysis.
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1.3.1 Safety Messages and Notes
The ICS-90 is designed for ion analysis applications and should not be 
used for any other purpose. If there is a question regarding appropriate 
usage, contact Dionex at 1-800-346-6390 before proceeding. Outside the 
United States, call the nearest Dionex office.

This manual contains warnings and precautionary statements that, when 
properly followed, can prevent personal injury and/or damage to the 
instrument. Safety messages appear in bold type and are accompanied by 
icons, as shown below.

Messages d’avertissement en français

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in death or serious injury.

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or
practice that may seriously damage the instrument, but will not cause
injury.

Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Signale une situation de danger immédiat qui, si elle n'est pas évitée,
entraînera des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures graves à mortelles.

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entraîner des blessures mineures à modérées. Également
utilisé pour signaler une situation ou une pratique qui pourrait
gravement endommager l'instrument mais qui n'entraînera pas de
blessures.
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Warnhinweise in Deutsch

Informational messages also appear throughout this manual. These are 
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They alert
you to an unexpected result of an action, suggest how to
optimize instrument performance, etc.

Bedeutet unmittelbare Gefahr. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zum Tod oder
schwerwiegenden Verletzungen führen.

Bedeutet eine mögliche Gefährdung. Mißachtung kann zu kleineren
oder mittelschweren Verletzungen führen. Wird auch verwendet, wenn
eine Situation zu schweren Schäden am Gerät führen kann, jedoch
keine Verletzungsgefahr besteht. 
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1.3.2 Safety Labels
The TUV GS, C, US Mark safety label and the CE Mark label on the 
ICS-90 indicate that the ICS-90 is in compliance with the following 
standards: EN 61010-1:2001 (safety), CAN/CSA-C22.2 No. 1010.1-
92+A2:97 (safety), UL 3101-1/10.93 (safety), and EN 
61326:1997+A1:1998 (EMC susceptibility and immunity).

The symbols below appear on the ICS-90, or on labels affixed to the 
ICS-90.

Alternating current

Protective conductor terminal

Power supply is on

Power supply is off

Indicates a potential hazard. Refer to the operator’s manual for 
an explanation of the hazard and how to proceed.
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2 • Description

The ICS-90 Ion Chromatography System is designed for simplicity and ease of 
use. It is configured for optimal performance at the factory. ICS-90 operation is 
controlled by Chromeleon software. This chapter presents a brief description of 
key ICS-90 features and components and the Chromeleon user interface.

Figure 2-1.  ICS-90 Ion Chromatography System
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2.1 Operating Features

2.1.1 Front Door and Top Cover
Figure 2-1 illustrates the front door and top cover of the ICS-90.

The front door contains a sample injection port and LEDs that indicate the 
ICS-90 operating status. The top cover is molded to hold the eluent and 
regenerant reservoirs.

LEDs

There are three status LEDs on the ICS-90 front 
panel. Other status information and alarm 
messages are displayed in Chromeleon software. 
See Section 4.1 for a description of the software 
alarm messages.

Injection Port

The sample to be analyzed is injected into the injection port, using either a 
syringe or the optional AS40 Automated Sampler. For more information 
about sample injection, see Section 3.5.6.

LED Label If On (Green) If Flashing

Power ICS-90 power is on Does not flash

Ready System check passed, but 
sequence not yet started 
(LED stays on until run starts 
or sequence is aborted)

System check failed (occurs if 
system check executes for 
10 minutes without success)

Run Running/acquiring data Error/alarm/fault (including 
injection valve position) 

Power

Ready

Run
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Eluent and Regenerant Reservoirs

The ICS-90 top cover is molded to hold one eluent reservoir assembly 
(P/N 057711) and one regenerant reservoir assembly (anion, P/N 057712; 
cation, P/N 057713).

• Eluent carries the sample through the ICS-90 and facilitates the ion 
separation process. Different types of eluents are used, depending on 
the analyses performed. For example, an ICS-90 configured for anion 
analyses uses carbonate eluent, and an ICS-90 configured for cation 
analyses uses methanesulfonic acid (MSA) eluent.

• Regenerant “regenerates” the suppressor’s ability to suppress eluent 
conductivity. An ICS-90 configured for anion analyses uses dilute 
sulfuric acid regenerant. An ICS-90 configured for cation analyses 
uses tetrabutylammonium hydroxide (TBAOH) regenerant.
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2.1.2 Rear Panel
Figure 2-2 illustrates the ICS-90 rear panel.

Power Switch

The power switch provides on/off control of power to the ICS-90. 

Figure 2-2.  ICS-90 Rear Panel
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Main Power Receptacle

The AC power outlet is located directly below the power switch.

USB Port

The USB port provides a connection to the Chromeleon computer. For the 
standard Chromeleon system configuration of one ICS-90 connected to a 
Chromeleon computer, connect a USB cable between the USB connector 
on the ICS-90 and a USB port on the computer. See Section B.4 for 
detailed connection instructions.

Link LED

The Link LED indicates the communication status 
between the ICS-90 and the Chromeleon computer.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-90 and is easily
accessible. 

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.

LED Name Status Description

Link On A link has been established between the ICS-90 
and the Chromeleon computer, but no data is 
currently being transmitted or received

Flashing A link has been established between the ICS-90 
and the Chromeleon computer and data is being 
transmitted

Off No link between the ICS-90 and the Chromeleon 
computer has been established

Link
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TTL Output Connector

The TTL output connector allows an AS40 Automated Sampler to receive 
TTL signals from the ICS-90. See Section B.17 for installation 
instructions.

Tubing Connections

Eight lines exit the ICS-90 from the lower left corner of the rear panel. 
These lines include: 

• 1 eluent line

• 1 regenerant line

• 1 cell outlet line

• 2 air lines

• 3 waste lines (sample, regenerant, and pump priming waste)
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2.1.3 Component Mounting Panel
Figure 2-3 shows the user-accessible components installed inside the 
ICS-90. The component panel is accessed by opening the front panel 
door. All of the components that the user can service are located on this 
panel.

DS5 Detection Stabilizer

The DS5 Detection Stabilizer (P/N 057290) houses a flow-through 
conductivity cell. Two 316 stainless steel electrodes are permanently 
sealed into the PEEK cell body. The cell measures the electrical 
conductance of analyte ions as they pass through the cell. 

Figure 2-3.  ICS-90 Component Mounting Panel
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Temperature directly affects the conductivity of a solution. For example, 
laboratory heating and air conditioning systems can cause a regular slow 
cycling in the baseline. This, in turn, can affect the reproducibility of an 
analysis. The higher the conductivity, the more pronounced the effect.

In ion analysis, the effect of temperature variation is minimized by 
suppressing eluent conductivity. Built-in preset temperature 
compensation also ensures that there is no major change in the baseline or 
in peak heights. Temperature compensation further improves baseline 
stability.

Direct conductive heating is used in the ICS-90 to provide temperature 
control and compensation. A heat exchanger inside the ICS-90 cell 
regulates the temperature. All data is collected at 40 °C (104 °F).

Figure 2-4.  DS5 Detection Stabilizer

To ELUENT OUT port
on suppressor

regenerant reservoir
CELL OUT to 

Connector to component
 mounting panel

DS5 Detection Stabilizer
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MMS III Suppressor

The MMS III suppressor reduces the eluent conductivity and enhances the 
conductivity of the sample ions, thereby increasing detection sensitivity. 

As illustrated in Figure 2-5, a 
constant flow of regenerant 
over the membrane 
continually restores the 
suppression ability of the 
MMS III. 

A process called 
Displacement Chemical 
Regeneration (DCR) pushes 
regenerant from the 
regenerant reservoir and 
through the suppressor. See 
Section 2.2.1 for details.

For more information about 
the MMS III, see Installation 
Instructions and 
Troubleshooting Guide for 
the Anion MicroMembrane 
Suppressor® III (Document 
No. 031727) or Installation 
Instructions and 
Troubleshooting Guide for 
the Cation MicroMembrane 
Suppressor® III (Document 
No. 031728).

Figure 2-5.   MMS III Suppressor Flow

Pressure Transducer

The pressure transducer measures the system pressure at the point that the 
eluent flows from the pump head outlet check valve into the pressure 
transducer. Pressure measurements, which can be monitored from 
Chromeleon, indicate that the pumping system is delivering smooth, 
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accurate flow. Pressure limits are used to detect high or low pressure 
conditions that might require the pump to be shut down.

The system backpressure should remain consistent. A significant increase 
in backpressure indicates a blockage in the liquid lines. A significant 
decrease in backpressure may indicate leaks or decreased pump flow due 
to an unprimed pump or insufficient eluent. 

Injection Valve with Sample Loop

The injection valve is a six-port, electrically-activated Rheodyne valve. A 
10-µL sample loop (P/N 042949) is installed on the valve at the factory.

The valve has two operating positions: Load and Inject (see Figure 2-6). 
Eluent flows through either the Load or Inject path, depending on the 
valve position.

• In the Load position, sample is loaded into the sample loop, where it 
is held until injection. Eluent flows from the pump, through the valve, 
and to the column, bypassing the sample loop. Sample flows from the 
syringe or automated sampler line (if installed), through the valve, 
and into the sample loop. Excess sample flows out to waste.

• In the Inject position, sample is swept to the column for analysis. 
Eluent flows from the pump, through the sample loop, and on to the 
column, carrying the contents of the sample loop with it.

Figure 2-6.  Rheodyne Injection Valve Flow Schematics
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Pump

The ICS-90 uses a high-speed reciprocating pump with PEEK 
components. The flow rate can be set to between 0.5 and 4.5 mL/min. The 
recommended operating flow rate is between 0.5 and 2.0 mL/min.
Prime Valve

The prime valve is mounted on the pump head. The pump should be 
primed at installation and whenever the flow rate seems outside normal 
parameters. For priming instructions, see Section B.13.

Separator and Guard Columns

Both the separator and guard columns are packed with resin filling and 
perform the separation of the sample ions. However, the main function of 
the guard column is to absorb organic contaminants and remove 
particulates that might poison the separator column. 
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2.2 Fluid Schematic

Figure 2-7 shows the flow path through the ICS-90 Ion Chromatography System.

Liquid flows through the ICS-90 along the following flow path:

• Eluent from the eluent reservoir is pressurized by the gas, forced into the 
pump, and passes through the pressure transducer. From there, it is pushed 
through a pulse damper/restrictor assembly, which smooths minor pressure 
variations from the high-speed pump to minimize baseline noise. The eluent 
then flows into the injection valve.

• When sample is loaded into the sample loop, the injection valve toggles to the 
Inject position. This combines the injected sample with the eluent and pushes 
it through the sample loop. 

Figure 2-7.  ICS-90 Flow Schematic
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• The eluent/sample mixture is pumped through the guard and separator 
columns, where the ions are separated by the ion exchange process (that is, 
different sample ions migrate through the columns at different rates, 
depending upon their interactions with the ion exchange sites).

• The eluent/sample mixture flows through the suppressor. There, detection 
sensitivity is enhanced by suppressing the conductivity of the eluent and 
enhancing the conductivity of the analyte. Regenerant flows continuously 
through the suppressor, restoring the ion exchange sites to their original state.

• The eluent/sample mixture then flows through the DS5, where the analytes 
are detected and a signal is produced and sent to Chromeleon software. 

• Finally, the eluent flows out of the cell and is directed into the regenerant 
reservoir, where it pressurizes the regenerant and forces it into the suppressor.

2.2.1 Displacement Chemical Regeneration (DCR)
Displacement Chemical Regeneration (DCR) is the process that 
regenerates the ability of the MMS III suppressor to suppress eluent. In 
DCR, the eluent/sample mixture that exits the cell is pumped into the 
regenerant reservoir. The eluent pressurizes the reservoir and pushes the 
regenerant into the suppressor. However, because the eluent is a different 
density than the regenerant, it remains separate. 

In the anion DCR process (see Figure 2-8), the eluent/sample mixture is 
lighter than the regenerant and it remains on the top, forcing the 
regenerant to the bottom of the reservoir and out into the suppressor. 

In the cation DCR process, the eluent/sample mixture is heavier than the 
regenerant and it flows to the bottom of the reservoir, displacing the 
regenerant and pushing regenerant out of the reservoir and into the 
suppressor. 
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Figure 2-8.  Anion ICS-90 Displacement Chemical Regeneration (DCR)
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2.3 The Chromeleon Interface

NOTE This section provides a brief overview of the
Chromeleon interface. For details, refer to the
Chromeleon Help or user’s manual. 

ICS-90 operation is controlled remotely through Chromeleon software. Two 
modes of software control are available: direct control and automated control.

• For direct control, you select operating parameters and commands from the 
Chromeleon menu bar, toolbars, and Control panels. Direct control commands 
are executed as soon as they are entered. Section 2.3.2 describes the 
commands available from the ICS-90 Control panels.

• For automated control, you create a list of samples (a sequence) to be 
processed automatically. The sequence includes programs with commands 
and parameters for controlling the ICS-90, acquiring sample data, and 
producing reports. Section 3.5.5 describes automatic sample processing.

2.3.1 The Chromeleon Browser

NOTE The Chromeleon Browser looks and functions like
Windows Explorer, but do not confuse the two. If you
copy files from the Chromeleon Browser into Explorer,
the files will be corrupted.

The Chromeleon Browser (see Figure 2-9) appears when you start 
Chromeleon. The Browser displays the directories in which 
chromatographic data is located, and allows you to open, move, and 
delete data.

• The left pane of the Browser shows the directory tree structure. By 
clicking the ‘+’ signs next to the folders and expanding the directory 
tree, you can access sequences, System Control panels, Wellness 
panels, and reports.

• The right pane displays information about the item selected in the left 
pane.
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Figure 2-9.  Chromeleon Browser

2.3.2 The ICS-90 Control Panels
Chromeleon provides two kinds of Control panels for the ICS-90. System 
Control panels (see Figure 2-10) are used for controlling and monitoring 
ICS-90 operation. Wellness panels are used for performing calibration 
and diagnostic functions. Section 5.1 describes the Wellness panels. 

Figure 2-10.  System Control Panel (ICS-90 with an AS40)
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ICS-90 System Control panels contain the following information and controls.

Sample Datasource
Displays the database in which the chromatographic data 
for the sample is saved.

Sequence
Displays the sequence in which this sample is included.

Sample
Displays the name of the sample that is running.

Elapsed Time
Displays the time that has elapsed since the sample analysis 
began.

Run Time
Displays the total run time.

AS40
(available only on the ICS-90_AS40 Control panel)
Displays the AS40 Automated Sampler status (Idle or 
Loading). 

Audit Trail Displays an account of every event that occurs during 
ICS-90 operation. This includes errors, status messages, 
operational events, etc.

ICS-90 System Connect
• Displays the connection status (Connected or 

Disconnected).

• Connect and Disconnect buttons control the ICS-90 
connection to the Chromeleon computer and determine 
whether there is communication between the ICS-90 
and the computer.

Conductivity
• Displays the offset conductivity and total conductivity.

• The Autozero button sets the conductivity to zero.
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Pump
• Displays the recorded flow rate (mL/min) and the 

current pump pressure.

• On and Off buttons turn the pump on and off.

Valve
• Displays the position of the injection valve 

(LoadPosition or InjectPosition).

• The Load and Inject buttons select the valve position.

Plot
Displays the ICS-90 detector signal plot.
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3 • Operation and Maintenance

ICS-90 Ion Chromatography System operation is controlled through Chromeleon 
software. However, three functions take place at the instrument:

• Eluent and regenerant preparation and/or reservoir installation

• On/off power control

• Manual sample or standard injection

The ICS-90 Ion Chromatography System is designed for IC (ion chromatography) 
applications and should not be used for any other purpose. Operation of the 
ICS-90 in a manner not specified by Dionex may result in personal injury. 

3.1 Preparing the Eluent

For instructions on preparing the eluent, refer to the column manual, which is 
included on the Dionex Reference Library CD-ROM (P/N 055405) in the 
ICS-90 Ship Kit.

3.2 Preparing the Regenerant

The type of regenerant used with the ICS-90 depends on the type of analysis to be 
run. A dilute sulfuric acid regenerant is used for anion analyses and a 
tetrabutylammonium hydroxide (TBAOH) regenerant is used for cation analyses. 
Follow the instructions below to prepare either anion or cation regenerant.

1. Fill the regenerant reservoir (anion, P/N 057712; cation, P/N 057713) about 
halfway with ASTM filtered, Type I (18-megohm) deionized (DI) water. 

For acid concentrates (such as the anion regenerant), always pour the
concentrate into deionized water, not into the empty reservoir.

Pour les concentrés acides (comme le régénérant anionique), versez
toujours le concentré dans de l'eau désionisée et non dans le
réservoir vide.
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2. Empty the entire bottle of concentrate into the reservoir.

3. Fill the concentrate bottle with DI water and empty the contents into the 
reservoir.

4. Continue to pour DI water into the reservoir until it is filled all the way to the 
top. If a few drops spill over, then it is full enough.

5. Insert the stopper assembly tubing into the reservoir and tighten the stopper. 

For additional information, refer to the Installation Instructions and 
Troubleshooting Guide for the Displacement Chemical Regeneration (DCR) Kit 
(Document No. 031664).

3.3 Pressurizing the Eluent Reservoir

1. Before beginning operation, verify that the clean gas supply is regulated to 
between 0.55 and 0.83 MPa (80 and 120 psi) and is connected to the gas inlet 
of the ICS-90 air regulator (see Figure 3-1). 

2. Verify that the gas line from the eluent reservoir is connected to the ICS-90 air 
regulator outlet line.

3. Make sure the eluent and regenerant reservoirs are filled, the caps are tightly 
screwed onto the reservoirs, and the lines connecting the eluent and 
regenerant reservoirs to the ICS-90 lines are securely connected. 

4. Pull out the air regulator knob and turn it clockwise to pressurize the eluent 
reservoir. 

Gießen Sie bei säurehaltigen Konzentraten (beispielsweise dem
Kationenelutionsmittel) das Konzentrat immer in entionisiertes
Wasser und nicht in den leeren Behälter.

The regenerant reservoir must be filled all the way to the top at all
times.

Do not shake the regenerant reservoir to mix the contents. The ICS-90
will stratify the contents.



3 • Operation and Maintenance

Doc. 031851-07 12/05 3-3

5. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the regulator 
knob back in. 

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus. 

Figure 3-1.  Reservoir Connections
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3.4 Preparing Samples

3.4.1 Collecting and Storing
Collect samples in high density polyethylene containers that have been 
thoroughly cleaned with deionized (DI) water. Do not clean containers 
with strong acids or detergents because these will leave traces of ions on 
the container walls. The ions may interfere with the analysis.

If samples will not be analyzed on the day they are collected, filter them 
through clean 0.45 µm filters immediately after collection; otherwise, 
bacteria in the samples may cause the ionic concentrations to change over 
time. Refrigerating the samples at 4° C (39° F) will reduce, but not 
eliminate, bacterial growth.

Analyze samples containing nitrite or sulfite as soon as possible. Nitrite 
oxidizes to nitrate, and sulfite to sulfate, thus increasing the measured 
concentrations of these ions in the sample. In general, samples that do not 
contain nitrite or sulfite can be refrigerated for at least one week with no 
significant changes in anion concentrations.

3.4.2 Pretreating
Analyze rainwater, drinking water, and air particulate leach solutions 
directly with no sample preparation (other than filtering and possibly 
diluting). 

Filter groundwater and wastewater samples through 0.45 µm filters 
before injection, unless samples were filtered after collection.

Before injection, pretreat samples that may contain high concentrations of 
interfering substances by putting them through Dionex OnGuard™ 
cartridges. Refer to the Installation and Troubleshooting Guide for 
OnGuard Cartridges (Document No. 032943) for instructions.

3.4.3 Diluting
Because the concentrations of ionic species in different samples can vary 
widely from sample to sample, no single dilution factor can be 
recommended for all samples of one type. In some cases (for example, 
many water samples), concentrations are so low that dilution is not 
necessary.
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Use eluent or ASTM filtered, Type I (18-megohm) deionized (DI) water 
to dilute the sample. When using carbonate eluents, diluting with eluent 
minimizes the effect of the water dip at the beginning of the 
chromatogram. If you dilute the sample with eluent, also use eluent from 
the same lot to prepare the calibration standards. This is most important 
for fluoride and chloride, which elute near the water dip.

To improve the accuracy of early eluting peak determinations, such as 
fluoride, at concentrations below 50 ppb, dilute standards in eluent or 
spike the samples with concentrated eluent to minimize the water dip. For 
example, spike a 100 mL sample with 1.0 mL of a 100 X eluent 
concentrate.

3.5 ICS-90 Operation

3.5.1 Starting Up the ICS-90
1. Make sure the eluent and regenerant reservoirs are filled, the caps are 

tightly screwed onto the reservoirs, and the lines connecting the 
eluent and regenerant reservoirs to the ICS-90 lines are securely 
connected (see Figure 3-1).

2. Make sure the clean gas inlet line is regulated to between 0.55 and 
0.83 MPa (80 and 120 psi), and is connected to the gas inlet of the 
ICS-90 air regulator (see Figure 3-1).

3. Make sure the gas line from the eluent reservoir is connected to the 
ICS-90 air regulator outlet line.

4. Make sure the air regulator is adjusted to between 30 and 40 kPa (5 
and 6 psi) (see Section 3.3).

5. Make sure the USB cable is connected to the USB port on the ICS-90 
rear panel. See Section B.4 for installation instructions.

6. Press the power switch on the ICS-90 rear panel (see Figure 2-2) to 
turn on the system power.

7. These are the conditions at power-up:

• The pump is off. 

• The injection valve is in the Load position.

• The DS5 is reading its current value.
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3.5.2 Starting Up Chromeleon
1. Turn on the computer. 

2. Check the Chromeleon Server icon on the Windows taskbar to 
determine whether the server is running. If the icon has a red X over 

it , the server is stopped. Start the server by right-clicking on 
the icon and selecting Start Server.

3. From the Windows Start menu, select Programs> 
Chromeleon>Chromeleon to start Chromeleon. A window similar 
to Figure 3-2 will open. If the Browser is not open, select Browser 
from the File menu to open it.

Figure 3-2.  Chromeleon Main Window and Browser

4. In the Browser, open the Dionex Templates\Panels\Dionex_IC\ICS-
90 System Panels folder and double-click one of the following 
ICS-90 Control panels (depending on whether an AS40 autosampler 
will be used): 
ICS-90_System
ICS-90_System_AS40
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5. Connect the ICS-90 to the Control panel by selecting 
Control>Connect to Timebase. Figure 3-3 is an example of the 
Dionex_ICS-90_System_AS40 Control panel. 

Figure 3-3.  Chromeleon System Control Panel (ICS-90 with an AS40)

6. Check the Control panel for the following:

• A steady operating pressure.

• The operating total conductivity background depends on the type 
of analysis to be performed. In general, it should be <30 µS for a 
system set up for anion analyses, and <2 µS for a system set up 
for cation analyses.

3.5.3 Preparing the ICS-90 for Operation
1. Turn on the pump by clicking the On button on the ICS-90 Control 

panel (see Figure 3-3).

2. Prime the pump (for instructions, see Section B.13).

3. Allow the system to equilibrate for 30 minutes. During equilibration, 
the ICS-90 Control panel displays the background conductivity (the 
conductivity of the eluent before sample injection). Offset the 
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background and zero the reading by clicking the Autozero button on 
the Control panel (see Figure 3-2).

NOTE If the ICS-90 pump is running but no data is
collected, the flow rate will remain constant
indefinitely. However, if the ICS-90 receives no
input from Chromeleon (you do not turn the pump
on or off, run a sequence, toggle the injection valve
position, etc.) for 6 hours after data is collected, the
module enters standby mode. In standby mode, the
pump flow is reduced to 1/20th of its normal rate. To
return to the normal flow rate, either begin a new
sequence or turn on the pump from the ICS-90
Control panel. 

3.5.4 Manual Sample Processing
To manually process a sample, select operating parameters and 
commands from the Chromeleon menu bar, toolbars, and Control panel. 
Commands are executed as soon as they are entered.

Summary of manual sample processing

1. Complete the steps in Sections 3.5.1, 3.5.2, and 3.5.3 to start the 
ICS-90, start Chromeleon, and prepare the ICS-90 for operation.

2. Inject the sample via a syringe, vacuum syringe, or autosampler (see 
Section 3.5.6).

3. Click the Autozero button on the Control panel.

4. Select Acquisition On from the Control menu. Chromeleon records 
the signal supplied by the detector and displays the signal plot on the 
Control panel.

5. To stop acquisition, select Acquisition Off from the Control menu.

NOTE Data from manual processing is saved in the
MANUAL sequence folder under the local
datasource in Chromeleon. This data is overwritten
each time a new manual sample is processed. To
save the data from a manual run, select the
MANUAL folder, select Save As from the File menu,
and enter a new name for the sequence.
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3.5.5 Automatic Sample Processing
For automated control, you create a list of samples (a sequence) to be 
processed automatically. For each sample, the sequence includes a 
program with commands and parameters for controlling the ICS-90, 
acquiring sample data, and generating reports. Additional sample 
processing parameters are included in the sequence (for example, the 
sample name, sample type, injection volume, etc.). After the sequence has 
been defined, automatic sample processing (also called batch processing) 
is started.

Summary of automatic sample processing

1. Complete the steps in Sections 3.5.1, 3.5.2, and 3.5.3 to start the 
ICS-90, start Chromeleon, and prepare the ICS-90 for operation.

2. Create a new control program or modify an existing one. 

To create a new program:

a. In the Browser, select File>New. Select Program File and click 
OK. 

b. Complete the steps in the Program Wizard, selecting the desired 
processing options. For help with any of the steps, click the Help 
button on the Program Wizard page.

3. Create a new sequence or modify an existing one.

To create a new sequence:

a. In the Browser, select File>New. Select Sequence (using 
Wizard) and click OK. 

b. Complete the steps in the Sequence Wizard, adding the desired 
number of samples and standards to the list and specifying the 
control program created in Step 2. For help with any of the steps, 
click the Help button on the Sequence Wizard page.

4. To start the sample processing, select Edit from the Batch menu.

5. Click the Add button on the Batch List tab and add the sequence you 
created in Step 3.

6. To start the batch, click the Start button.
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Sample Processing Events (Default)

The following events occur if samples are processed using the default 
control program created with the Program Wizard:

• The pump is turned on.

• If an AS40 autosampler is being used, the AS40 load cycle is started. 
If no autosampler is being used, the program pauses for you to 
manually load the sample into the sample loop.

• After the AS40 load cycle is complete or you manually load the 
sample, the background conductivity is offset from the total, thereby 
zeroing the baseline conductivity value. 

• The injection valve position is switched to the Inject position.

• Data acquisition is turned on.

• The injection valve returns to the Load position after 1 minute.

• Data acquisition is turned off after 30 minutes.

3.5.6 Sample Injection
There are three ways to inject sample into the ICS-90: via syringe, 
vacuum syringe, or autosampler.

Injection via a Syringe

1. Make sure the injection port on the ICS-90 front door (see Figure 2-1) 
is connected to the sample port S (5) on the injection valve (see 
Figure 3-4).

2. Fill the 1 cc syringe (P/N 016388) provided in the ICS-90 Ship Kit 
(P/N 059947) with a calibration standard or sample.

3. Insert the syringe into the injection port on the ICS-90 front door.

4. Overfill the sample loop with several sample loop volumes. Excess 
sample will exit through the injection valve waste line.

5. Leave the syringe in the port.
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6. Switch the injection valve to start the injection. The method used 
depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), click the 
Inject button on the Chromeleon Control panel (see Figure 3-3). 

• For automatic sample processing (see Section 3.5.5), Chromeleon 
pauses at the start of the program to allow you to load the sample 
loop (Steps 1 through 4 above). After loading the loop, click OK. 
Chromeleon automatically switches the injection valve position 
and continues running the program.

Injection via a Vacuum Syringe

1. Disconnect the waste line from port W (6) of the injection valve (see 
Figure 3-4) and attach a shorter line (10 to 12 inches of PEEK or 
Teflon® tubing).

2. Place the free end of the line into the sample.

3. Insert the 1 cc syringe (P/N 016388) provided in the ICS-90 Ship Kit 
(P/N 059947) into the injection port on the ICS-90 front door (see 
Figure 2-1) and pull the plunger out to “suck” the sample into the 
injection valve.

4. Switch the injection valve to start the injection. The method used 
depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), click the 
Inject button on the Chromeleon Control panel (see Figure 3-3).

Figure 3-4.  Injection Valve Connections
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• For automatic sample processing (see Section 3.5.5), Chromeleon 
pauses at the start of the program to allow you to load the sample 
loop (Steps 1 through 3 above). After loading the loop, click OK. 
Chromeleon automatically switches the injection valve position 
and continues running the program.

Injection via the AS40 Automated Sampler

1. Verify that the AS40 output line is connected to port S (5) of the 
ICS-90 injection valve, and the LOAD connector from the AS40 Relay 
Control cable is connected to the ICS-90 TTL Output connector on 
the rear panel. See Section B.17 for detailed installation instructions.

2. The injection process depends on how you are processing samples:

• For manual sample processing (see Section 3.5.4), load the 
injection valve sample loop as instructed in the AS40 Automated 
Sampler Operator’s Manual (Document No. 034970). Then, click 
the Inject button on the Chromeleon Control panel (see 
Figure 3-3) to start the injection.

• For automatic sample processing (see Section 3.5.5), the 
Chromeleon program contains commands that start the AS40 
sample load cycle and switch the ICS-90 injection valve position.
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3.6 Maintenance

This section describes routine maintenance procedures for the ICS-90 that users 
may perform. All other maintenance procedures must be performed by Dionex 
personnel.

As Needed
• Make fresh eluent as needed.

• Regularly check the eluent reservoir to see if it needs to be refilled.

• Whenever the eluent reservoir is refilled, the regenerant reservoir should also 
be emptied, rinsed, and refilled with regenerant.

Daily
• Check the ICS-90 component mounting panel (see Figure 2-3) for leaks or 

spills. Wipe up spills. Isolate and repair leaks (see Section 4.2). Rinse off any 
dried eluent or regenerant with deionized water.

• Check the waste container daily and empty when needed.

Weekly
• Once a week, check gas and fluid lines for crimping or discoloration. Relocate 

any pinched lines. Replace damaged lines.

• Check the junction between the pump head and the pump casting for evidence 
of liquid leaks. Normal friction and wear may gradually result in small liquid 
leaks around the piston seal. If unchecked, these leaks can gradually 
contaminate the piston housing, causing the pump to operate poorly. If leaks 
occur, replace the piston seals (see Section 5.6).

Yearly
• Change the pump seals (see Section 5.6).

• Rebuild the injection valve (see Section 5.9).

• Replace the AS40 Automated Sampler tip and tubing. The ASM/AS40 
Sample Tip Replacement Kit (P/N 040835) contains all of the components 
required to replace the sampling tip and the tubing between the tip and the 
injection valve. For instructions on how to replace the sampling tip, see the 
AS40 Automated Sampler Operator’s Manual (Document No. 034970).
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4 • Troubleshooting

This chapter is a guide to troubleshooting problems that may occur while 
operating the ICS-90 Ion Chromatography System. 

• Section 4.1 describes the error messages displayed in the Chromeleon Audit 
Trail. 

• The remaining sections in this chapter describe other operating problems and 
how to resolve them.

If you are unable to eliminate a problem, contact Dionex for help. In the U.S., call 
Dionex Technical Support at 1-800-346-6390. Outside the U.S., call the nearest 
Dionex office.

4.1 Alarms and Error Conditions

Chromeleon displays a message in the Audit Trail if any of the following alarm 
conditions occurs.

• PUMP OVER PRESSURE ALARM

The ICS-90 has a maximum system pressure limit of 28 MPa (4000 psi). In 
addition, the pressure limit can be lowered from Chromeleon (in the Server 
Configuration or in the control program). If the system pressure exceeds the 
set limit for at least 0.5 second, Chromeleon will stop the pump and the 
following error message will appear in the Audit Trail:

To troubleshoot:

1. Check for blockages in the liquid lines by working your way 
backward from the cell to the pump (see Figure 2-7 for the flow 
schematic). 

2. Restart the pump from the ICS-90 Control panel in Chromeleon.

The system pressure has exceeded the limit.
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• PUMP UNDER PRESSURE ALARM 

The system pressure has fallen below the low pressure limit, which is set from 
Chromeleon (in the Server Configuration or in the control program). 
Chromeleon will stop the pump and display the following error message in 
the Audit Trail:

To troubleshoot:

1. Make sure the eluent reservoir is full.

2. Check for liquid leaks (see Section 4.2).

3. Prime the pump (see Section B.13).

4. Restart the pump from the ICS-90 Control panel in Chromeleon.

• LOAD/INJECT VALVE ERROR

If the injection valve fails to switch positions within 1 second of being 
toggled, the ICS-90 Moduleware will report an error to Chromeleon and the 
following error message will be displayed in the Audit Trail:

To troubleshoot:

1. If a sequence is being executed, terminate the sequence by selecting 
Stop from the Batch menu.

2. Turn off the ICS-90 power briefly and then restart.

3. Try to toggle the valve from Load to Inject by clicking the Manual 
Override button on the ICS-90 Control panel in Chromeleon. 

4. If the problem persists, call Dionex for assistance.

The pump has lost prime.

Load/inject valve error.
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• OVER CONDUCTIVITY

This message usually appears for the first few minutes after the ICS-90 is 
started. If the message appears at other times, it indicates a problem.

To troubleshoot:

1. Perform the suppressor QuickStart procedure:

a. Disconnect the separator column outlet line and connect it to the 
DS5 cell inlet line.

b. Turn on the pump from the ICS-90 Control panel in Chromeleon 
and allow the suppressor to regenerate for 5 minutes.

c. Turn off the pump and allow the suppressor to hydrate for 
5 minutes.

d. Reconnect the separator column outlet line and cell inlet line. 

2. If the high background persists:

• Prepare fresh eluent.

• Prepare fresh regenerant.

• Verify the cell calibration by pumping deionized water through 
the cell (bypassing the column(s) and suppressor). The total 
background should be less than 1.0 µS.

• Perform the suppressor off-line regeneration procedure. For 
instructions, refer to the suppressor manual.

• If the problem persists, replace the suppressor (see Section 5.11).

• DATA BUFFER OVERFLOW ERROR

Various electronics-related problems can cause the following error message to 
be displayed in the Audit Trail:

If this warning appears, call Dionex for assistance. The ICS-90 
electronics components cannot be serviced by the user. 

Conductivity exceeds limit.

Module data buffer overflow. Data may have been lost.
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4.2 Liquid Leaks

• Leaking fitting

Locate the source of the leak. Tighten or, if necessary, replace the liquid line 
connection (see Section 5.2). Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for tightening requirements.

• Broken liquid line

Replace the line and fittings (see Section 5.2).

• Blocked or improperly installed line

Make sure the lines are not crimped or otherwise blocked. Also, if the blocked 
line is a waste line, make sure it is not elevated at any point after it exits the 
ICS-90. If a line is blocked, replace it (see Section 5.2).

• Loose pump check valve housing

Make sure the check valves are firmly seated in the pump head. If they are 
not, tighten them carefully with an open-end wrench just until the leak stops.

• Damaged pump piston seal

1. Replace the piston seal (see Section 5.6).

2. If the problem persists, replace the piston (see Section 5.7).

• Pump head not tight against casting

Carefully tighten the pump head mounting nuts just until the leak stops. DO 
NOT OVERTIGHTEN!

• Leaking pressure transducer

Make sure the liquid line connections into the pressure transducer are tight. 
Refer to Installation of Dionex Liquid Line Fittings (Document No. 031432) 
for tightening requirements. Replace any damaged fittings.

• Leaking pump head waste valve

Make sure the waste valve is closed. To close the valve, turn the knob 
clockwise, just until tight. DO NOT OVERTIGHTEN! Overtightening 
may damage the valve and the pump head.

Inspect the pump head. If the waste valve is the source of the leak, replace the 
waste valve O-ring (see Section 5.8). 
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• Leaking MMS III

Refer to the suppressor manual for troubleshooting procedures. The 
suppressor manual is included on the Dionex Reference Library CD-ROM 
(P/N 055405), located in the ICS-90 Ship Kit.

• Leaking injection valve

Make sure the liquid line connections to the transducer are tight. Refer to 
Installation of Dionex Liquid Line Fittings (Document No. 031432) for 
tightening requirements. Replace any damaged fittings.

Liquid leaks from behind the valve stator may indicate a scratched rotor seal. 
Rebuild the injection valve (see Section 5.9).

• Leaking DS5 Detection Stabilizer 

Check the waste lines for blockage; trapped particles can plug the lines and 
cause a restriction and/or leak. If necessary, clear the waste lines by reversing 
the direction of flow.

Make sure the plumbing downstream from the cell is clear; a blockage may 
overpressurize the cell, causing it to leak. If the problem continues, contact 
Dionex for assistance.

4.3 Pump Difficult to Prime or Loses Prime

• Empty eluent reservoir and/or no eluent connected

Fill the reservoir. Make sure all connections are secure. 

• Eluent reservoir not pressurized

Make sure the gas line is properly connected between the air regulator and the 
reservoir, and that the inlet gas supply is regulated to between 0.55 and 
0.83 MPa (80 and 120 psi) and connected to the air regulator. Make sure the 
eluent reservoir cap is screwed on tightly. See Section B.9 and Section B.10 
for detailed connection instructions. 

• Dirty check valve

Clean and/or replace the pump check valve (see Section 5.5).

• Liquid leaks at junction between pump head and pump casting

Replace the piston seal (see Section 5.6).
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4.4 Pump Does Not Start

• No power (front door Power LED indicator fails to light)

Check that the power cord is plugged in.

Check the main power fuses and replace if needed (see Section 5.12).

• No communication between ICS-90 and Chromeleon (Link LED on rear 
panel fails to light)

The USB cable is not connected correctly. See Section B.4 for installation 
instructions.

4.5 No Flow

• Pump not primed

Prime the pump (see Section B.13).

• Broken pump piston

Replace the piston (see Section 5.7).

4.6 Erratic Flow

• Pump needs priming

Prime the pump (see Section B.13).

• Damaged piston seal

Replace the piston seal (see Section 5.6).

• Dirty pump check valve

Clean or replace the check valve (see Section 5.5).

4.7 Excessive System Backpressure

• Restriction in the system plumbing

Check all liquid lines for crimping or blockage. Make sure the ferrule fittings 
are not overtightened onto tubing. Refer to Installation of Dionex Liquid Line 
Fittings (Document No. 031432) for details.
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• Plugged or damaged fitting

Isolate the faulty fitting by loosening fittings, one by one, until the pressure 
returns to normal. Repair or replace the fitting (see Section 5.2).

• Flow rate through the columns too high

Measure the pump flow rate and set it to the correct rate (see Section B.14).

• Clogged column bed supports

Refer to the instructions in the column manual for troubleshooting guidance. 
The column manual is included on the Dionex Reference Library CD-ROM 
(P/N 055405), located in the ICS-90 Ship Kit.

• Contaminated columns

Clean the columns as instructed in the column manual. 

• Plugged Rheodyne valve passages

Rebuild the injection valve (see Section 5.9).

4.8 Peak “Ghosting” 

Ghosting is the appearance of extraneous peaks in a chromatogram. These may be 
late-eluting peaks from a previous injection or they may result from a 
contaminated, malfunctioning, or incorrectly installed injection valve. These 
peaks may co-elute with peaks of interest, resulting in nonreproducible peak 
heights/areas.

• Insufficient time between sample injections

Wait until the previous sample has been completely eluted before making 
another injection. 

• Insufficient flush between samples

Flush the sample loop with at least 10 loop volumes of deionized water or 
sample between sample injections.

• Incorrect or contaminated standards

Remake standards.

• Incorrect or contaminated eluent

Remake the eluent (see Section 3.1).



ICS-90 Ion Chromatography System

4-8 Doc. 031851-07 12/05

• Malfunctioning injection valve

Contact Dionex for assistance.

4.9 Nonreproducible Peak Height or Retention Time

• Column overloading

Dilute the sample (see Section 3.4.3).

• Liquid leaks

Locate and eliminate the leaks (see Section 4.2). 

• Incomplete or imprecise filling of the sample loop

1. Fill the sample loop until excess sample exits the waste line.

2. Inspect the 1 cc syringe (P/N 016388) and replace if damaged.

• Pump not primed properly

Prime the pump (see Section B.13).

4.10 Abnormal Retention Time or Selectivity

• Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

• Contaminated or degraded sample

Take appropriate precautions when preparing and storing samples to prevent 
contamination and degradation (see Section 3.4).

• Contaminated column

1. Clean the column as instructed in the column manual. The column 
manual is included on the Dionex Reference Library CD-ROM 
(P/N 055405), located in the ICS-90 Ship Kit.

2. If cleaning is unsuccessful, replace the column.
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4.11 No DS5 Response

• DS5 not properly installed

Check that the DS5 is plugged into the component mounting panel and 
screwed down until the bottom of the DS5 is flush against the sheet metal 
panel (see Figure 2-3 and Figure 2-4).

• No flow from pump

Several conditions may cause this condition; see Section 4.4 and Section 4.5 
for details.

• Cell electronics malfunctioning

Use the Chromeleon Wellness panel diagnostics to test the electronics with a 
dummy cell (see Section 5.1 and the Chromeleon Help for instructions). If the 
variance reading is outside the tolerance range (less than 1 µS), the electronics 
are malfunctioning. Call Dionex for assistance.

4.12 High DS5 Output

• Background not suppressed by suppressor

If Conductivity exceeds limit is displayed in the Chromeleon Audit Trail, 
follow the instructions in Section 4.1. Refer to the suppressor manual for 
additional troubleshooting guidance. The suppressor manual is included on 
the Dionex Reference Library CD-ROM (P/N 055405), located in the ICS-90 
Ship Kit.

• Sample concentration too high

Dilute the sample (see Section 3.4.3).

• Wrong eluent or regenerant

Check that you are using the correct eluent and regenerant for your system 
(see Section 3.1).

• Cell out of calibration

Recalibrate the cell from the Chromeleon Wellness panel (see Section 5.1).
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4.13 Baseline Noise or Drift

• Flow system leak; erratic baseline

Check all fittings and liquid lines for leaks. Tighten or, if necessary, replace 
all liquid line connections. Refer to Installation of Dionex Liquid Line Fittings 
(Document No. 031432) for tightening requirements.

• Trapped gases

Release any trapped gases in the cell by loosening the lines to and from the 
cell and then retightening them. Also loosen and retighten the fittings to and 
from the MMS eluent ports.

• Pump not properly primed

Prime the pump (see Section B.13).

• Contaminated or incorrect eluent and/or regenerant

Remake the eluent and regenerant (see Section 3.1).

• Rapid changes in ambient temperature

If the ambient temperature does not meet the specification of 10 to 35 °C (50 
to 95 °F), make sure that air conditioning and heating vents are directed away 
from the ICS-90 and the ICS-90 front door is closed.

• Insufficient system equilibration following changes to operating 
parameters; especially apparent when operating at high sensitivities

Allow a longer system equilibration time (up to 2 hours) before starting 
operation.

• Incorrect suppressor operating conditions

Refer to the suppressor manual for troubleshooting information.

• Cell above or below temperature

Call Dionex for assistance.

• Damaged piston seal

Replace the piston seal (see Section 5.6).

• DCR backpressure tubing not installed

Install the tubing on the end of the suppressor waste line (see Section B.8).
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5 • Service

This chapter describes routine service procedures that users may perform. Other 
service procedures must be performed by Dionex personnel.

NOTE The ICS-90 Ion Chromatography System electronics
components cannot be serviced by the user. Repair of
electronics components must be performed by Dionex.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to 
isolate the cause of the problem. When ordering replacement parts, please include 
the ICS-90 model number and serial number. To contact Dionex in the U.S., call 
1-800-346-6390. Outside the U.S., call the nearest Dionex office.

Substituting non-Dionex parts may impair ICS-90 performance, thereby voiding 
the product warranty. Refer to the warranty statement in the Dionex Terms and 
Conditions for more information.

5.1 Diagnostics and Calibrations

Chromeleon allows you to perform diagnostic and calibration procedures and to 
monitor ICS-90 functions from the Wellness panel (see Figure 5-1). This section 
provides an overview of Wellness panel features. For instructions on performing 
calibrations, see the following sections:

• Calibrating the Pressure Transducer (Section 5.1.1)

• Calibrating the Cell (Section 5.1.2)

To open the Wellness panel:
1. Open the Chromeleon Browser and expand the Dionex Templates folder. 

2. Expand the Panels folder and then the Wellness folder.

3. In the right pane of the Browser window, double-click Dionex_ICS-
90_wellness.pan.The Wellness panel appears.



ICS-90 Ion Chromatography System

5-2 Doc. 031851-07 12/05

Figure 5-1.  Chromeleon Wellness Panel

Use the Wellness panel to monitor and/or perform the following functions:

System Status • The check box to the left of the ICS-90 LED indicates the 
connectivity status. When the check box is gray, there is no 
connectivity between the ICS-90 and the Chromeleon 
computer.

• The ICS-90 serial number is displayed to the right of the 
ICS-90 LED.

• While a calibration or diagnostic procedure is running, the 
Calibration or Diagnostic box is green.

Audit Trail • The Audit Trail displays an account of every event that 
occurs during ICS-90 operation. This includes errors, status 
messages, operational events, etc.

System • The current total system Pressure is displayed.

• The current electrochemical detector (ECD) conductivity is 
displayed.
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Calibration • Pressure Transducer
• The offset, slope, and date of the last calibration are 

displayed.

• The Measured field is in the slope calibration. See 
Section 5.1.1 for instructions.

• The Calibrate Offset and Calibrate Slope buttons 
are used to calibrate the pressure transducer. See 
Section 5.1.1 for instructions.

• Conductivity Cell
• The offset, slope, and date of the last DS5 calibration 

are displayed.

• The Calibrate Offset or Calibrate Slope buttons are 
used to calibrate the cell. See Section 5.1.2 for 
calibration instructions.

• Click the Details button to open a window that shows the 
factory-set calibration values, the current values, and the 
previous set of calibration values. The factory and last set of 
calibration values can be downloaded from this window.

Diagnostic • The last calibrated pressure and conductivity variance, 
minimum, and maximum readings for the DS5 are 
displayed.

• The Start and Stop buttons start and stop the readings.

• To determine the conductivity variance of the electronics 
alone, select the Dummy Cell box and then click Start. The 
variance reading should be less than 1 µS.
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5.1.1 Calibrating the Pressure Transducer

NOTE About 10 minutes before starting this calibration
procedure, toggle the injection valve position a few times
by clicking the valve Load and Inject buttons on the
ICS-90 Control panel in Chromeleon. This removes any
air or contaminant buildup in the injection valve loop.

1. Turn off the pump flow from the ICS-90 Control panel in 
Chromeleon.

2. Open the waste valve on the front of the pump head (see Figure 5-2) 
by turning the knob counterclockwise two turns.

3. Open the ICS-90 Wellness panel in Chromeleon. To do this:

a. In the Chromeleon Browser, expand the Dionex Templates 
folder, and then the Panels and the Wellness folder.

b. In the right pane of the Browser window, double-click 
Dionex_ICS-90_wellness.pan.

4. Click the Calibrate Offset command button under pressure 
transducer (see Figure 5-1). The pump calibrates the transducer and 
uploads the new value to Chromeleon. The new offset is stored as the 
current value.
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5. Close the waste valve.

6. Connect a pressure gauge between the pump outlet and the pressure 
transducer (see Figure 5-2). Turn on the pump and let the system 
stabilize. Note the average pressure reading on the gauge, and enter 
this reading in the measured field.

7. Click the Calibrate Slope command button under pressure 
transducer. The pump calibrates the slope and uploads the new value 
to Chromeleon. The new slope is stored as the current value.

8. Turn off the pump.

9. Disconnect the pressure gauge. Reconnect the pressure transducer to 
the pump.

Figure 5-2.  ICS-90 Interior Components

Pressure
Transducer

Pump Head
Waste Valve

DS5 Detection
Stabilizer
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5.1.2 Calibrating the Cell
Calibrate the cell every 6 months or after installing a new DS5 Detection 
Stabilizer.

1. Open the ICS-90 Wellness panel in Chromeleon. To do this:

a. In the Chromeleon Browser, expand the Dionex Templates 
folder, and then the Panels and the Wellness folder.

b. On the right pane of the Browser window, double-click 
Dionex_ICS-90_wellness.pan.

2. Use an Allen wrench to remove the two screws securing the DS5 to 
the ICS-90 component mounting panel (see Figure 5-2). Save the 
screws.

3. Pull the DS5 straight out from the component mounting panel to 
unplug the cell from its electronics. Let the DS5 hang by the tubing.

4. Allow the conductivity to stabilize for 5 to 10 minutes.

5. Click the Calibrate Offset command button under conductivity cell 
(see Figure 5-1).

6. Line up the 9-pin connectors on the DS5 and the component 
mounting panel and plug the DS5 back into the electronics. Replace 
the mounting screws (removed in Step 2) and tighten.

7. Disconnect the pump outlet line from port P (2) on the injection 
valve; connect the line directly to the cell inlet, using the yellow 
PEEK backpressure tubing (P/N 049715).

8. Fill an eluent bottle with 1.0 mM KCl solution and connect it to the 
eluent out line. Prime the pump (see Section B.13) and then turn on 
the pump.

9. Verify that there is a minimum of 7 MPa (1000 psi) of backpressure.

Items Needed Description

1.0 mM KCl solution Prepare by dissolving 0.07456 g of reagent-
grade KCl in one liter of 18-megohm DI 
water.

Backpressure tubing to provide 
at least 7 MPa (1000 psi)

Use 0.076-mm (0.003-in) ID yellow PEEK 
tubing (P/N 049715).
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10. Allow the conductivity to stabilize for 5 to 10 minutes. 

11. Click the Calibrate Slope command button under conductivity cell. 
The cell is calibrated and a new cell calibration constant is uploaded 
to Chromeleon. The new value is stored as the current cell calibration 
constant. 

After calibration, the conductivity reading should be 147.00 ± 
2 µS/cm. If this is not the case, call Dionex for assistance.

12. Flush the KCl solution from the system by pumping DI water through 
the cell. When the conductivity drops to near zero, stop the pump 
flow.

13. Reconnect the pump to the injection valve and reconnect the line 
from the suppressor to the cell inlet.
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5.2 Replacing Tubing and Fittings

The ICS-90 is plumbed with the tubing and tubing assemblies listed below.

• 10-32 fittings (P/N 043275) and ferrules (P/N 043276) are used for most 
tubing connections. For tightening requirements, refer to Installation of 
Dionex Liquid Line Fittings (Document No. 031432).

• 1/8-in fittings (P/N 052267) and ferrules (P/N 048949) are used for 
connections to the MMS III REGEN OUT port and the eluent and regenerant 
reservoirs.

• 1/16-in fittings (P/N 052230) and ferrules (P/N 052231) are used for 
connections from the injection port to the injection valve.

Tubing Size and Type Used For

0.125-mm (0.005-in) ID PEEK 
(P/N 044221) 

Connection from pump pulse damper to 
injection valve

0.25-mm (0.010-in) ID PEEK 
(P/N 042690) 

Connections between other system 
components

0.30-mm (0.012-in) ID Tefzel® 
(P/N 048904)

Connection from injection port to injection 
valve

0.75-mm (0.030-in) ID PEEK 
(P/N 044777)

Connection from injection valve to waste and 
between the DS5 and regenerant reservoir
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5.3 Changing the Sample Loop

Figure 5-3 shows the injection valve connections. The injection valve is plumbed 
at the factory with all tubing and fittings for connection to the pump, injection 
port, and column. A 10 µL PEEK sample loop (P/N 042949) is installed at the 
factory between ports L and L. Always replace the pre-installed 10 µL loop with 
another of the same size. 

1. Turn off the pump from the ICS-90 Control panel in Chromeleon.

2. Open the ICS-90 front door.

3. Disconnect the sample loop from ports L and L on the injection valve (see 
Figure 5-3).

4. Install the new sample loop between ports L and L on the injection valve.

5. Make sure the loop is tightly coiled so the door can close securely.

6. Close the door.

7. Turn on the pump from the ICS-90 Control panel.

Figure 5-3.  Injection Valve Plumbing
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5.4 Isolating a Restriction in the Liquid Plumbing

A restriction in the liquid plumbing will cause excessive system backpressure.

1. Begin pumping eluent through the system (including the columns).

2. Follow the ICS-90 flow schematic (see Figure 2-7) and work backward 
through the system, beginning at the cell exit. One at a time, loosen each 
fitting and observe the pressure. The connection at which the pressure drops 
abnormally indicates the point of restriction.

If the restriction has caused such high pressure that the system cannot be 
operated, you must work forward through the flow schematic, adding parts 
one at a time until an abnormal pressure increase (and hence, the restriction) is 
found.

3. If the restriction is in the tubing or fitting, remove the restriction by back 
flushing or by replacing the tubing or fitting.

5.5 Cleaning and Replacing Pump Check Valves

A dirty check valve causes an erratic flow rate. It may also cause the pump to lose 
prime and/or be difficult to reprime.

1. Prime the pump (see Section B.13). If the pump does not stay primed, go to 
the next step.

2. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

3. Open the front door of the ICS-90.

4. Disconnect the tube fittings from both the inlet and outlet pump check valve 
housings (see Figure 5-4).

5. Using a 1/2-in box wrench or an adjustable wrench, carefully remove both 
check valve housings from the pump head.

6. Place the check valves in a beaker of methanol and sonicate or agitate for 
several minutes.

7. Rinse each check valve thoroughly with filtered, deionized water.
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8. Reinstall the check valves in the pump head. Be sure to install the inlet check 
valve (which a 1/4-28 port) on the bottom of the head and the outlet check 
valve (which has a 10-32 port) on the top. Tighten only enough to seat. 

9. Reconnect the liquid lines. Close the front door. 

10. Reconnect the power cord, and turn on the power switch on the ICS-90.

11. Prime the pump (see Section B.13). If the pump will not prime, and you have 
eliminated all other possible causes of the problem, replace both check valves 
(inlet check valve, P/N 047660; outlet check valve, P/N 047661).

Figure 5-4.  Pump Head Assembly

Overtightening may damage the pump head or the check valve
housing and crush the check valve seats.
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5.6 Replacing a Pump Piston Seal

A damaged piston seal allows leakage around the piston at the head mounting 
plate or around the base of the pump head. Flow rates will be unstable and there 
may be baseline noise.

1. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

2. Open the ICS-90 front door.

3. Disconnect the tube fittings from the inlet and outlet check valves (see 
Figure 5-4).

4. Hold the head firmly against the pump housing, to compensate for the spring 
loading, and remove the two nuts (see Figure 5-5).

Lateral motion when disengaging the head from the piston can break
the piston.

Un mouvement latéral pendant la séparation de la tête et du piston
peut casser le piston.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf vom Kolben
lösen. Andernfalls kann der Kolben brechen. 

Figure 5-5.  Removing the Pump Head
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5. Slowly release the head, allowing it to separate from the housing. 
CAREFULLY disengage the head from the sapphire piston by pulling the 
head straight off and away from the mounting guides (see Figure 5-5). Be 
especially careful not to snap the piston if the internal spring sticks to the 
piston guide. 

6. Place the head, front end down, on a clean work area. Lift off the piston guide 
and back-up washer to expose the seal (see Figure 5-6).

7. Remove the piston seal from the head. Discard the seal.

8. Remove the O-ring and back-up seal from the back-up washer.

9. Carefully push the new piston seal (P/N 055870) into the head. When 
properly installed, the piston seal is almost flush with the indented surface of 
the head.

10. Press a new back-up seal (P/N 036901) into the O-ring (P/N 035776). If 
necessary, also replace the O-ring. Then press the O-ring and back-up seal 
into the back-up washer assembly (P/N 057233).

11. Press the back-up washer assembly into the head, followed by the piston 
guide (P/N 035030).

12. Remove the spring, spring guide, piston, spring retainer, and retainer ring 
from the pump housing (see Figure 5-7). Inspect the interior of the housing 
for liquid and corrosion. Clean up any spills and carefully clean any signs of 
corrosion from the interior of the housing. 

Figure 5-6.  Pump Head Assembly
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13. Clean and inspect the piston. If it is scored or scratched, replace it (see 
Section 5.7).

14. Reinstall the retainer ring, spring retainer, piston, spring guide, and spring in 
the pump housing.

15. Carefully slide the pump head straight onto the mounting guides. Guide the 
spring onto the piston guide. Apply gentle pressure to push the piston through 
the seal.

16. Hold the head firmly against the pump housing and replace the two nuts. Use 
a wrench to tighten them evenly.

17. Reconnect the liquid lines to the inlet and outlet check valves on the pump 
head assembly (see Figure 5-4).

18. Reconnect the power cord and turn on the power switch.

19. Prime the pump (see Section B.13). 

Figure 5-7.  Piston Assembly

Avoid all lateral motion when sliding the head onto the piston. Failure
to slide the head straight on will break the piston, as well as damage
the piston seal and back-up seal.

Évitez tout mouvement latéral lorsque vous faites coulisser la tête sur
le piston. Un coulissement non rectiligne de la tête cassera le piston
et en endommagera le joint étanche et le joint étanche de sécurité.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf auf den
Kolben schieben. Andernfalls kann der Kolben abbrechen und die
Kolbendichtung sowie die Hinterspülungsdichtung zerstört werden.
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5.7 Replacing a Pump Piston

Continued leaking from around the pump head after replacing the piston seal 
indicates a scratched or broken piston.

1. Turn off the power switch on the ICS-90 rear panel and disconnect the power 
cord.

2. Open the ICS-90 front door.

3. Disconnect the tube fittings from the inlet and outlet check valves (see 
Figure 5-4).

4. While holding the head firmly against the pump housing to compensate for 
the spring loading, remove the two nuts (see Figure 5-6).

5. Slowly release the head and allow it to separate from the housing. 
CAREFULLY disengage the head from the sapphire piston by pulling the 
head straight off and away from the mounting guides (see Figure 5-5). Be 
especially careful not to snap the piston if the spring is stuck to the piston 
guide.

6. Remove the piston guide, spring, spring guide, spring retainer, and piston by 
pulling them straight out, away from the pump housing (see Figure 5-7).

7. If the piston is broken, replace the piston seal and the back-up seal (see 
Section 5.6). This will prevent pieces of broken piston from scratching the 
new piston assembly.

8. Remove the retainer ring (P/N 035010) from the old piston assembly and 
install it on the new piston assembly (P/N 036904).

Lateral motion when disengaging the head from the piston can break
the piston.

Un mouvement latéral pendant la séparation de la tête et du piston
peut casser le piston.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf vom Kolben
lösen. Andernfalls kann der Kolben brechen. 
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9. Carefully slide the spring retainer onto the piston assembly.

10. Slide the assembled piston back into the piston housing.

11. Slide the spring over the piston, positioning it flush against the spring retainer.

12. Carefully slide the pump head straight onto the alignment rods. Guide the 
spring over the piston guide. Gently push the piston through the seal. 

13. Hold the head firmly against the pump housing and replace the two nuts. Use 
a wrench to tighten them evenly.

14. Reconnect the liquid lines to the check valve housings.

15. Reconnect the power cord and turn on the power switch.

16. Prime the pump (see Section B.13).

Avoid all lateral motion when sliding the head onto the piston. Failure
to slide the head straight on will break the piston, as well as damage
the piston seal and back-up seal.

Évitez tout mouvement latéral lorsque vous faites coulisser la tête sur
le piston. Un coulissement non rectiligne de la tête cassera le piston
et en endommagera le joint étanche et le joint étanche de sécurité.

Vermeiden Sie Seitwärtsbewegungen, wenn Sie den Kopf auf den
Kolben schieben. Andernfalls kann der Kolben abbrechen und die
Kolbendichtung sowie die Hinterspülungsdichtung zerstört werden.
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5.8 Replacing the Waste Valve O-Ring

A damaged O-ring causes leakage around the base of the waste valve knob.

1. Turn off the pump from the ICS-90 Control panel in Chromeleon.

2. Open the front door of the ICS-90.

3. Turn off the gas pressure to the eluent reservoir.

4. Remove the valve from the pump head housing by turning the knob 
counterclockwise until it comes loose from the housing (see Figure 5-8).

5. Remove the O-ring.

6. Carefully slide a new O-ring (P/N 035776) over the end of the valve and push 
it into the groove.

7. Reinstall the valve in the pump head housing, turning the knob clockwise 
until the valve is firmly seated. Do not overtighten the valve knob.

8. Turn on the gas pressure to the eluent reservoir.

9. Close the ICS-90 front door.

10. Prime the pump (see Section B.13).

NOTE If the pump head leaks after replacing the waste valve
O-ring, the valve knob may not have been seated firmly
enough. Tighten the knob further, but only by hand.
Never use a tool.

Figure 5-8.  Pump Head Assembly
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5.9 Rebuilding the Injection Valve

Dionex recommends rebuilding the injection valve annually. The Injection Valve 
Rebuild Kit (P/N 057896) contains all required replacement parts.

NOTE Substitution of non-Dionex parts may impair valve
performance and void the product warranty.

1. Turn off the pump from the ICS-90 Control panel in Chromeleon.

2. Open the front door of the ICS-90.

3. Disconnect each liquid line connected to the injection valve.

4. Follow the instructions provided in the LC25 Injection Valve Maintenance Kit 
(P/N 055676) to replace the rotor seal, isolation seal, and stator face.

5. Reconnect all liquid lines to the injection valve.

6. Close the ICS-90 front door.

7. Turn on the pump from the ICS-90 Control panel.
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5.10 Installing a New DS5 Detection Stabilizer

1. Turn off the power on the ICS-90 rear panel and disconnect the power cord.

2. Open the ICS-90 front door.

3. Disconnect the black ELUENT OUT line from the ELUENT OUT port on the 
suppressor (see Figure 5-9). 

4. Disconnect the orange CELL OUT line from the union that connects it to the 
black CELL OUT line.

5. Use an Allen wrench to remove the two screws on the top of the DS5. 

6. Remove the DS5 by unplugging it from the component mounting panel. 

7. Plug the new DS5 (P/N 057290) into its mounting location.

8. Replace the screws on the top of the DS5 and tighten.

9. Attach the orange CELL OUT line from the DS5 to the union attached to the 
black CELL OUT line. Attach the ELUENT OUT line to the ELUENT OUT port on 
the suppressor.

Figure 5-9.  DS5 Detection Stabilizer Assembly



ICS-90 Ion Chromatography System

5-20 Doc. 031851-07 12/05

10. Close the front door.

11. Reconnect the power cord and turn on the ICS-90 power. 

12. Calibrate the cell (see Section 5.1.2).

5.11 Installing a New Suppressor

Refer to the suppressor manual for guidance about when to replace a suppressor. 
The suppressor manual is included on the Dionex Reference Library CD-ROM 
(P/N 055405), located in the ICS-90 Ship Kit.

1. Turn off the pump from the ICS-90 Control panel in Chromeleon.

2. Open the front door of the ICS-90.

3. Disconnect the four eluent and regenerant lines from the suppressor.

4. Slide the suppressor to the left to detach it from the component mounting 
panel.

5. Slide the new suppressor (AMMS III suppressor, P/N 056751; CMMS III 
suppressor, P/N 056753) to the right until it locks into place on the mounting 
panel.

6. Connect the four eluent and regenerant lines to the new suppressor.

7. Close the ICS-90 front door.

8. Prime the pump (see Section B.13).
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5.12 Changing the Main Power Fuses

1. Turn off the main power and disconnect the power cord.

2. The fuse holder is part of the main power receptacle on the ICS-90 rear panel. 
Note the recessed lock located on each side of the fuse holder (see 
Figure 5-10). 

Using a small screwdriver, push each lock toward the center to release it. 
When both locks are released and the fuse holder pops out slightly, pull the 
fuse holder straight out of its compartment.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the ICS-90.

HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arrière du ICS-90.

HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Rückseite des ICS-90.

Figure 5-10.  Main Power Fuse Holder
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3. Replace the two fuses in the holder with new IEC 127 fast-blow fuses rated 
3.15 amps (P/N 054745). Dionex recommends always replacing both fuses.

4. Reinsert the fuse holder into its compartment. The fuse holder is keyed to fit 
only in its proper orientation. Apply sufficient pressure evenly against the 
holder to engage the two locks. The holder is flush against the panel when 
both locks are engaged. 

5. Reconnect the main power cord and turn on the power.
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A • Specifications

A.1 Electrical

A.2 Physical

Main Power Two voltage/frequency configurations (not user-selectable):
110–120 VAC/60 Hz
220–240 VAC/50 Hz
100 VAC/50 Hz

 Fuses Two fast-blow IEC 127 fuses rated 3.15 A (P/N 954745) 

Dimensions
(with reservoirs

and tubing)

Height without reservoirs: 32.125 cm (12.85 in)
Height with reservoirs and cap tubing: 59.63 cm (23.85 in)
Width: 23.23 cm (9.29 in)
Depth: 39.73 cm (15.89 in)

Weight 14 kg (30 lb)

Decibel Level < 53 dBA
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A.3 Environmental

A.4 Front Panel

 Operating
Temperature

10 to 35 °C (50 to 95 °F)

Humidity 5% to 95% relative humidity, noncondensing

 Gas Pressure Laboratory-quality clean gas regulated to between 0.55 and 
0.83 MPa (80 and 120 psi)

Operating
Pressure

28 MPa (4000 psi) maximum liquid path (tubing, valve, columns, 
etc.)

Operational
LED Indicators

LEDs display the ICS-90 operational status: 

• Power
Off: No power
On: Power present

• Ready
Off: Not connected to Chromeleon
On: System check passed and the ICS-90 is connected to 
Chromeleon
Flashing: System check failed (occurs if system check 
executes for 10 minutes without success)

• Run
Off: Not running
On: Running/acquiring data
Flashing: Error/alarm/fault (including injection valve position 
fault)
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A.5 Rear Panel

A.6 Pump

A.7 Pulse Damper

Link LED The Link LED displays the communication status between the 
ICS-90 and Chromeleon: 
Off: There is no communication link between the ICS-90 and 
Chromeleon.
On: The communication link between the ICS-90 and Chromeleon 
is activated, but data is not being transmitted or received.
Flashing: The communication link between the ICS-90 and 
Chromeleon is activated and data is being transmitted or received.

Type High performance pump with metal-free flow path and PEEK 
components

Operation Mode Constant volume

Flow Rate 0.5 to 4.5 mL/min

Operating
Pressure

28 MPa (4000 psi) maximum 

Type 0.75-mm (0.030-in) ID tubing

Maximum
Pressure

28 MPa (4000 psi)
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A.8 Detector

A.9 DS5 Detection Stabilizer

A.10 Injection Valve

A.11 Delay Volume

Range Digital signal range of 0 to 500 µS or 0 to 10,000 µS (user-
selectable)

Temperature
Compensation

Preset for accurate reading at 40 ºC

Cell Drive 8 kH square wave

Auto Offset -999 to 999 µS

Control and
Data Evaluation

Provided by Chromeleon software. Communication with the 
ICS-90 is via USB (Universal Serial Bus).

Linearity 1%

Cell Body PEEK

Electrodes Passivated 316 stainless steel

Active Volume 1 µL

Maximum
Pressure

2.0 MPa (300 psi)

Injection Valve Two-position, six-port, electrically-activated Rheodyne valve with 
PEEK wetted components

System Total <5 mL
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B • Installation

This chapter provides instructions for the initial installation of the ICS-90 Ion 
Chromatography System. 

NOTE These installation instructions are also shipped with the
ICS-90 as a printed manual (Document No. 031856).

B.1 Facility Requirements

• Make sure the ICS-90 installation site meets the power and environmental 
specifications listed in Appendix A.

• The ICS-90 requires a sturdy workbench of a height that ensures convenient 
access to the interior.

• Allow at least 15 cm (6 in) behind the ICS-90 for power connections and 
ventilation. For optimal performance, install the ICS-90 in a draft-free 
location, out of the path of air conditioning and heating vents.

• A clean gas source regulated to between 0.55 and 0.83 MPa (80 and 120 psi) 
is required for pressurization of the eluent reservoir.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.
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B.2 Unpacking the ICS-90 System

B.2.1 Unpacking the ICS-90

1. Open the shipping box.

2. Remove the eluent reservoir assembly and the ICS-90 Ship Kit 
(P/N 059947).

3. Remove the foam cover.

4. Using the cardboard side handles, carefully remove the ICS-90 from 
the box. You may need to remove the foam at the sides of the ICS-90 
before you can lift the instrument from the box.

5. Set the ICS-90 on a workbench and cut the tape to remove the plastic 
surrounding the instrument.

6. Inspect the ICS-90 for any shipping damage.

Lift the ICS-90 only from each side of the cabinet bottom. Lifting from
the front door will damage the door hinges. Use caution when lifting
the module: it weighs 19 kg (42 lb).

Ne soulevez le ICS-90 que par le fond ou les côtés. Son soulèvement
par la porte du panneau avant endommagera les charnières de la
porte. Soyez prudent lorsque vous soulevez le ICS-90: il pèse 19 kg
(42  lb).

Heben Sie das ICS-90 nur an, indem Sie von beiden Seiten unter den
Boden greifen. Wenn Sie das Gerät an der Vordertür anheben,
beschädigen Sie die Türangeln. Vorsicht beim Heben des Moduls: Es
wiegt 19 kg.
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B.2.2 Removing the Pump Shipping Screw

1. Carefully lay the ICS-90 on its back or side.

2. Locate the middle screw on the bottom of the ICS-90 (see 
Figure B-1). This screw secures the pump in place during shipment.

3. Use a Phillips screwdriver to remove the shipping screw. 

4. A screw holder is located to the right of the screw (see Figure B-1). 
Place the screw in the holder for safekeeping. You will need to 
reinstall the screw if the ICS-90 is shipped to another location.

5. Return the ICS-90 to an upright position.

Figure B-1. Pump Shipping Screw Removal

Shipping Screw
Screw Holder

Bottom View of ICS-90

Front

Rear
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B.2.3 Unpacking the Computer (North America only)

1. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

2. Remove the monitor from its box and place it on the workbench.

3. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

4. Go on to Section B.4.

B.2.4 Unpacking the Computer (outside North America)

1. Refer to Installing the Chromeleon Chromatography Management 
System with a Dionex Ion Chromatograph (Document No. 031883) to 
verify that the computer being used meets Chromeleon specifications.

2. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

3. Remove the monitor from its box and place it on the workbench.

4. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

5. If Chromeleon is already installed on the computer, go on to 
Section B.4. Otherwise, go on to Section B.3 to install Chromeleon.
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B.3 Installing Chromeleon

NOTES
• Windows 2000 is required for controlling the ICS-90.

• To install Chromeleon, you must log onto Windows 2000 with 
administrator or power user privileges. Administrator privileges are not 
required to run Chromeleon.

1. Turn on the computer power.

2. Follow the Windows 2000 setup steps as they appear on screen.

3. Verify that the monitor display is set to a minimum of 1024 x 768 with 16-bit 
color.

4. Insert the Chromeleon CD-ROM into the CD-ROM drive.

5. The Chromeleon Setup menu appears.

6. If the Setup menu does not appear automatically, go to the Autorun folder on 
the Chromeleon CD-ROM and double-click autorun.exe.

7. Select Launch Chromeleon Setup.

8. Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear. 

9. When prompted, select whether to add the Chromeleon Server Monitor to the 
Startup group. If you select yes, the Server Monitor starts automatically when 
the computer is started, and the program icon appears on the taskbar.
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B.4 Connecting the ICS-90 to the Computer

The ICS-90 rear panel (see Figure B-4) provides a USB receptacle for connecting 
the ICS-90 to a USB port on the Chromeleon PC or a USB hub.

1. Locate the USB A-B cable (P/N 960777) in the ICS-90 Ship Kit. 

Before connecting the USB cable and turning on the ICS-90 power,
verify that Chromeleon is installed on the PC (see Section B.3).

When Chromeleon is installed first, the USB driver information is
loaded when the power is turned on. Chromeleon then automatically
detects the new USB device. Refer to Installing the Chromeleon
Chromatography Management System with a Dionex Ion
Chromatograph (Document No. 031883) for installation instructions
and for details about USB connections.

Figure B-2. ICS-90 Rear Panel

Main Power 
Receptacle

Power Switch

Waste Lines

Liquid Lines

USB 
Receptacle

TTL 
Connector
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2. Connect the cable between the ICS-90 and computer as shown in 
Figure B-3.

NOTE All USB connections require standard USB A-to-B
cables.

3. If there are no unused USB ports on the PC, connect the ICS-90 to an 
external USB hub (P/N 060392) and connect the Chromeleon PC to 
the hub (see Figure B-4). 

Figure B-3. Example Connections: One ICS-90 Connected to the Computer

Figure B-4. Example Connections: Three ICS-90s Connected to an External Hub
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NOTE If the dongle provided with Chromeleon is for a USB
port, remember to reserve a USB port on either the PC
or the hub for the dongle.

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB hub (P/N 060392). One or more
hubs is also required if the ICS-90 or other USB device
is more than 5 meters (16 ft) from the PC. Refer to the
manual provided by the hub vendor for complete
installation instructions. 

B.5 Connecting the Power Cord

1. A label on the ICS-90 rear panel indicates the line frequency (60 Hz or 50 Hz) 
and voltage (110 to 120 VAC or 220 to 240 VAC) for which the system is 
designed. Make sure the frequency and voltage are appropriate for your 
location. If you are unsure, consult an electrician.

2. Connect the power cord (IEC 320 C13) from the main power receptacle on 
the rear panel (see Figure B-2) to a grounded power source.

The USB standard limits the USB cable length to 5 meters (16 ft). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters
(32 yds) from the PC.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-90 or connect it to AC power mains
without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-90 and is easily
accessible. 

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-90.
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B.6 Turning on the ICS-90 Power

1. Turn on the computer power. Log onto Windows 2000 as an administrator or 
power user.

2. Turn on the power to the ICS-90. Windows 2000 automatically detects the 
new USB device. A message flashes on the screen to inform you that the 
device was detected.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.

Before turning on the ICS-90 power, verify that Chromeleon software
is installed. See Section B.3 for installation instructions. If
Chromeleon is not installed first, Windows 2000 will be unable to
identify the new USB device.
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B.7 Setting Up Chromeleon 

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon Help or user’s guide.

B.7.1 Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-90, a valid software 
license must be installed. To install the license, you first install a dongle 
on the computer and then enter a license “Key Code” in Chromeleon. (A 
dongle is an adapter that is connected to the parallel PC interface or USB 
port. The dongle stores the serial number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required. 

1. Plug the dongle into the appropriate port on the computer (either the 
parallel or USB port, depending on the type of dongle). For a parallel 
port dongle, also tighten the connector screws.

2. If it is not already running, start the Chromeleon Server Monitor 
(select Start>Chromeleon>Server Monitor). The Server Monitor 
window opens. 

• If Chromeleon was installed on the computer before shipping, the 
Server Monitor status will display “Chromeleon Server is running 
idle.” (This is because the license Key Code was entered before 
shipping.) If this is the case, click Close and go on to “Creating a 
Timebase” (see Section B.7.2).
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• If Chromeleon was not pre-installed, the Server Monitor status 
displays “Chromeleon Server is running idle (Evaluation Mode).” 
(see Figure B-5) If this is the case, go on to Step 3.

Figure B-5. Server Evaluation Mode

3. Open the Chromeleon Server Configuration program (select 
Start>Chromeleon>Server Configuration).

4. Select Edit>Properties to open the Server Configuration properties 
dialog box (see Figure B-6). Click Dongle and then enter the Key 
Code provided with the Chromeleon license. Click OK.

Figure B-6. Server Configuration Properties
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5. Check the Server Monitor status. It should now display “Chromeleon 
Server is running idle.” (see Figure B-7).

Figure B-7. Server Running

6. Click Close to close the Server Monitor window.

B.7.2 Creating a Timebase

1. In the Server Configuration program, select Edit>Add Timebase.

2. A clock icon appears under the server name with a default name 
highlighted. To use the default name, press Enter. To use a different 
name, type the name and press Enter. Figure B-8 shows an example 
timebase named ICS-90.

Figure B-8. Example: Creating a Timebase
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3. Select Edit>Add Device. The Add device to timebase dialog box 
appears.

Figure B-9. Add Device Dialog Box

4. Select ICS-90 IC System from the list and click OK. A dialog box 
appears.

Figure B-10. ICS-90 Configuration Properties: Live Mode
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5. On the General tab page, Live Mode is selected by default. Select 
the ICS-90 serial number from the drop-down list. If you are 
installing more than one ICS-90, you can verify the serial number for 
each system by checking the label at the top of the component panel 
(see Figure B-19).

6. Click Options to display the Options tab page.

7. Select the conductivity range (0 to 500 µS or 0 to 10,000 µS) from the 
drop-down list under Set Detection Limits. Selecting the larger 
(coarse) range reduces the detector’s resolution by a factor of 20.

NOTE The Set Detection Limits option is not enabled
unless Moduleware version >1.3 is installed in
your ICS-90.

8. Click OK to close the properties dialog box. 

9. Save the configuration (select File>Save Installation). 

10. The Server Configuration Check message window appears. You can 
ignore the “no inject device installed” warning, if it appears. This 
simply means that the timebase does not include an autosampler. 
Click Close.



B • Installation

Doc. 031851-07 12/05 B-15

11. Exit the Server Configuration program.

B.7.3 Connecting the ICS-90 to a Chromeleon Control Panel

1. Start Chromeleon (select Start>Chromeleon>Chromeleon). If the 
Browser does not open automatically, select File>Browser to open it.

Figure B-11. Chromeleon Main Window and Browser

2. In the Browser, open the Dionex Templates\Panels\Dionex_IC\ICS-
90 System Panels folder and double-click one of the following 
ICS-90 Control panels (depending on whether an AS40 autosampler 
will be used):

• Dionex_ICS-90_System

• Dionex_ICS-90_System_AS40
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3. If a “Cannot connect to timebase…” message appears, click OK to 
close it.

NOTE If the timebase was named “ICS-90” when it was
created, the Control panel opens and connects
automatically to the ICS-90 timebase.

4. If the Control panel opens with the controls not yet active (see 
Figure B-12), connect the ICS-90 to the Control panel by selecting 
Control>Connect to Timebase.

Figure B-12. Dionex_ICS-90_AS40_System Control Panel (Unconnected)
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5. A dialog box appears (see Figure B-13). 

Figure B-13. Connect to Timebase

6. Click the ‘+’ sign beside My Computer on the right side of the 
dialog box and select the timebase you created in Section B.7.2. Click 
OK to close the dialog box.

The controls on the panel are now connected (see Figure B-14).

Figure B-14. Dionex_ICS-90_AS40_System Control Panel (Connected)
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B.7.4 Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-90 by clicking the 
Disconnect and then the Connect button on the Control panel, while 
observing the ICS-90 front panel LEDs. 

If Chromeleon and the ICS-90 are communicating correctly, the Power 
and Ready LEDs are on when the ICS-90 is connected to Chromeleon, 
and only the Power LED is on when it is disconnected.

Figure B-15. ICS-90 LEDs Connected and Disconnected States
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B.8 Connecting the Waste Lines

Untape the coiled waste and liquid lines from the rear panel. Place the ends of the 
three waste lines into a waste container. The waste lines siphon off prime waste 
from the pump head, sample overflow from the injection valve, and system waste 
from the suppressor. 

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

A DCR waste backpressure tubing assembly (P/N 060214) is installed
on the free end of the MMS III waste line (see Figure B-16). The
assembly consists of a coupler and a 6-inch length of 0.25-mm
(0.010-in) ID black tubing. 

The tubing assembly provides a small amount of backpressure to
compress any air bubbles formed in the suppressor’s regenerant
chamber. If you shorten or replace the MMS III waste line, remember to
reinstall the backpressure tubing assembly. Failure to do so will result
in high baseline drift.

Figure B-16. DCR Waste Backpressure Tubing Assembly

Suppressor
Waste Line

0.25-mm (0.010-in) ID
Black Tubing

Coupler
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B.9 Connecting the Gas Source

1. Locate the barbed fitting (P/N 030071), pipe thread reducer (P/N 030087), 
1/8-in ID tubing (P/N 040793), and ICS-90 air regulator accessory 
(P/N 060054) in the ICS-90 Ship Kit. 

2. Use the barbed fitting and pipe thread reducer to connect the 1/8-in ID tubing 
to a clean gas source, regulated to between 0.55 and 0.83 MPa (80 and 
120 psi). 

3. Push the other end of the tubing onto the inlet of the air regulator (see 
Figure B-17).

NOTE Do not turn on the gas source. Do not pressurize until
the eluent is prepared and the ICS-90 is plumbed.

Figure B-17. ICS-90 Air Regulator Accessory

Gas Inlet Line 
3-mm (1/8-in) ID

Connect to gas 
source

Eluent Gas Line
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B.10 Setting Up the Eluent and Regenerant Reservoirs

1. Rinse the eluent and regenerant reservoirs.

2. Prepare 2 L of eluent. For instructions, see the manual for the column being 
installed. The column manual is included on the Dionex Reference Library 
CD-ROM (P/N 055405), located in the Ship Kit.

3. Follow the instructions below to prepare either anion (dilute sulfuric acid) or 
cation (tetrabutylammonium hydroxide (TBAOH)) regenerant.

a. Fill the regenerant reservoir (anion, P/N 057712; cation, P/N 057713) 
about halfway with ASTM filtered, Type I (18-megohm) deionized (DI) 
water. 

b. Empty the entire bottle of concentrate into the reservoir.

c. Fill the concentrate bottle with DI water and empty the contents into the 
reservoir.

d. Continue to pour DI water into the reservoir until it is filled all the way to 
the top. If a few drops spill over, then it is full enough.

e. Insert the stopper assembly tubing into the reservoir and tighten the 
stopper. 

For acid concentrates (such as the anion regenerant), always pour the
concentrate into deionized water, not into the empty reservoir.

Pour les concentrés acides (comme le régénérant anionique), versez
toujours le concentré dans de l'eau désionisée et non dans le
réservoir vide.

Gießen Sie bei säurehaltigen Konzentraten (beispielsweise dem
Kationenelutionsmittel) das Konzentrat immer in entionisiertes
Wasser und nicht in den leeren Behälter.

The regenerant reservoir must be filled all the way to the top at all
times.

Do not shake the regenerant reservoir to mix the contents. The ICS-90
will stratify the contents.



ICS-90 Ion Chromatography System

B-22 Doc. 031851-07 12/05

For additional information, refer to the Installation Instructions and 
Troubleshooting Guide for the Displacement Chemical Regeneration (DCR) 
Kit (Document No. 031664). The manual is included on the Dionex Reference 
Library CD-ROM (P/N 055405), located in the ICS-90 Ship Kit.

4. Make sure the regenerant reservoir is filled almost to overflowing. 

5. Slip the air regulator accessory bracket over the neck of the eluent reservoir.

6. Install the caps on the eluent and regenerant reservoirs and hand tighten.

7. Place the reservoirs in the holders on the top cover of the ICS-90.

8. Connect the liquid lines from the ICS-90 to the lines exiting the eluent and 
regenerant reservoir caps (see Figure B-18) as follows:

• Connect the two lines labeled Eluent Bottle Out. 

• Connect the two lines labeled Regen Bottle Out.

• Connect the line labeled Regen In to the green Regen Bottle In line from 
the ICS-90.

Figure B-18. Reservoir Connections

Gas Inlet Line 
(from gas source)

Eluent Gas 
Line

Regen Bottle 
In Line

Regen Bottle 
Out Line

Eluent Bottle 
Out Line
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9. To ensure the correct operating pressure for the suppressor, either one or two 
backpressure coil(s) (P/N 045877) must be installed between the cell outlet 
and the regenerant reservoir inlet. The number of coils required depends upon 
the application flow rate:

a. For flow rates less than 2 mL/min, verify that two coils are installed.

b. For flow rates of 2 mL/min or more, remove one of the backpressure 
coils.

NOTE Refer to the flier Backpressure Coil Pressure Test for
Dionex Suppressors (Document No. 031759) (shipped
with the suppressor) for details about suppressor
operating pressure requirements.

10. Connect the orange gas line from the eluent reservoir to the gas line on the air 
regulator outlet.

B.11 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. For
detailed installation information, refer to the column
and suppressor manuals, which are provided on the
Dionex Reference Library CD-ROM (P/N 055405). 

1. Remove the guard column, separator column, and MMS III suppressor from 
their boxes. Remove the fitting plugs from the ends of each column and from 
all ports on the suppressor. Discard the tubing that temporarily connected the 
suppressor ports.

2. Plumb the guard and separator columns. Refer to the labels on the tubing, to 
Figure B-19, and to the following instructions.

Application Flow Rate Number of Required
Backpressure Coils

Less than 2 mL/min 2

2 mL/min or more 1
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a. Remove the union connecting GUARD IN and GUARD OUT and connect 
GUARD IN to the guard column inlet. Check the arrow on the column 
label; it should point away from the injection valve.

b. Connect GUARD OUT to the guard column outlet.

c. Push the guard column onto the clips.

d. Remove the union connecting COL IN and COL OUT and connect COL IN to 
the separator column inlet. Connect COL OUT to the separator column 
outlet. Check the arrow on the column label. It should point toward the 
cell (DS5).

e. Push the column onto the clips.

Figure B-19. ICS-90 Component Panel (Door not shown)
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Suppressor 
Brackets 

Regen In/Out 
Union (remove)

Eluent
In/Out
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Serial Number

Cell Out
Union

Verify that 1
or 2 back-
pressure
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shown in

photo)

Do not 
remove
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3. Plumb the MMS III suppressor as follows:

a. Install the suppressor onto the brackets located below the DS5 (see 
Figures B-19 and B-20).

b. Remove the union connecting ELUENT IN and ELUENT OUT and connect 
ELUENT IN and ELUENT OUT to the corresponding ports on the suppressor.

c. Remove the union connecting REGEN IN and REGEN OUT and connect 
REGEN IN and REGEN OUT to the corresponding ports on the suppressor.

4. To ensure the correct operating pressure for the suppressor, either one or two 
backpressure coil(s) (P/N 045877) must be installed between the cell outlet 
and the regenerant reservoir inlet. The number of coils required depends upon 
the application flow rate:

Figure B-20. ICS-90 with Columns and Suppressor Installed

Application Flow Rate Number of Required
Backpressure Coils

Less than 2 mL/min 2

2 mL/min or more 1

Separator 
Column

MMS III 
Suppressor

Guard Column
Side slot for 
autosampler 
line



ICS-90 Ion Chromatography System

B-26 Doc. 031851-07 12/05

a. For flow rates less than 2 mL/min, verify that two coils are installed.

b. For flow rates of 2 mL/min or more, remove one of the backpressure 
coils.

NOTE Refer to the flier Backpressure Coil Pressure Test for
Dionex Suppressors (Document No. 031759) (shipped
with the suppressor) for details about suppressor
operating pressure requirements.

B.12 Pressurizing the Eluent Reservoir

NOTE Do not pressurize the regenerant reservoir.

1. Pull out the air regulator knob and turn it fully counterclockwise to ensure 
there is no pressure to the reservoir when the gas source is turned on. 

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the eluent 
reservoir. 

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the regulator 
knob back in. 

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus. 
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B.13 Priming the Pump

1. Verify that the eluent and regenerant reservoirs are filled, the reservoir caps 
are installed and hand -tightened, and the gas and liquid lines are connected to 
the reservoirs (see Section B.10).

2. Verify that the gas supply is turned on, the eluent reservoir is pressurized (see 
Section B.12), and the regenerant reservoir is unpressurized. Note: The 
regenerant reservoir is unpressurized if the reservoirs are connected as 
described in Section B.10. 

3. Verify that the waste lines are directed to a waste container.

4. To start the liquid flow, open the pump head waste valve (see Figure B-21) by 
turning the knob counterclockwise two turns. When the valve is open, eluent 
flows directly from the pump to waste.

5. Let the liquid flow for at least 2 to 3 minutes to ensure that there are no 
trapped gas bubbles in the line from the eluent reservoir to the pump head. 

NOTE The factory set flow rate is 0.5 mL/min at 10 MPa
(1500 psi) of backpressure. Prime the pump at the
factory flow rate, and then go on to Section B.14 to set
the flow rate for your application.

6. Turn on the pump from the ICS-90 Control panel in Chromeleon. Allow the 
pump to run with the waste valve open for 30 seconds.

7. Close the waste valve knob.
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Figure B-21. ICS-90 Interior Components
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B.14 Setting the Pump Flow Rate

1. Locate the production test chromatogram on the Dionex Quality Assurance 
Report (supplied with the separator column). Note the backpressure and flow 
rate listed for the column.

2. Pull out the flow rate knob on the component mounting panel (see 
Figure B-21) and turn the knob slowly to the right to begin adjusting the 
pressure. 

NOTES
• There is about a 10-second delay between adjusting the knob and the 

pressure reading response on the Chromeleon Control panel.

• The flow rate shown on the Control panel is a recorded value only. It 
does not change when the flow rate knob is adjusted. 

3. Adjust the knob until the pump pressure reading on the Control panel reaches 
the figure listed on the production test chromatogram.

NOTE The production test chromatogram is produced without
a guard column. If a guard column is installed, adjust
the knob until the pressure is about 1.4 to 2.1 MPa (200
to 300 psi) above the backpressure listed for the
separator column alone. 

4. Measure the flow rate, using one of the following methods: 

• Volumetrically (recommended for most applications): Measure the 
volume of liquid collected over a measured time period. The Ship Kit 
includes items for measuring the flow rate volumetrically.

• Gravimetrically: Weigh the mass of liquid collected over a measured 
time period. The gravimetric method is slightly more accurate than 
the volumetric method.
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Volumetric Method 1 (Recommended): Using a Syringe and Adapter

a. Locate the following items in the ICS-90 Ship Kit: luer fitting 
(P/N 024305), luer coupler (P/N 042806), 1 mL syringe (P/N 016388), 
and 10 mL syringe (P/N 016387). You will also need a stopwatch or a 
clock or watch with a second hand (the computer’s clock can be used), 
and a small beaker or other container for collecting waste.

b. Connect the luer coupler to the luer fitting. 

c. Select the syringe to be used: 

• For a 0.5 mL/min flow rate, use the 1 mL syringe

• For a flow rate above 0.5 mL/min, use the10 mL syringe

d. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. Connect the luer coupler to the ELUENT IN line, and connect 
the syringe to the luer fitting (see Figure B-22) 

e. Using a stopwatch or clock’s second hand, time the flow of eluent into the 
syringe for 60 seconds. Determine the volume collected by noting the 
beginning and ending positions of the syringe plunger. 

f. The volume of eluent collected in 60 seconds should be approximately 
equal to the desired flow rate in milliliters per minute. For example, for a 
flow rate of 1 mL/min, the volume should be 1.0 ± 0.1 mL.

g. If necessary, adjust the flow rate knob, and then repeat the measurement. 
Continue adjusting until the desired milliliters per minute is collected.

h. Reconnect the ELUENT IN line to the suppressor.

Figure B-22. Assembled Syringe and Luer Adapter
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Volumetric Method 2: Using a Graduated Cylinder

a. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

b. Using a clock or watch with a second hand (the computer’s clock can be 
used), collect eluent from the ELUENT IN line into a small graduated 
cylinder for 2 minutes.

c. The collected eluent should be approximately equal to the desired flow 
rate in milliliters per minute. For example, for a flow rate of 1 mL/min, 
2.0 ± 0.2 mL should be collected in 2 minutes.

d. If necessary, adjust the flow rate knob, and then repeat the measurement. 
Continue adjustments until the desired eluent per minute is collected.

e. Reconnect the ELUENT IN line to the suppressor.

Gravimetric Method

a. Disconnect the ELUENT IN line from the ELUENT IN port on the 
suppressor. 

b. Using a tared beaker and a calibrated stopwatch, collect the eluent from 
the ELUENT IN line for 60 seconds.

c. Weigh the mass of the eluent. The mass (in grams) should be 
approximately equal to the desired flow rate in milliliters per minute. For 
example, for a flow rate of 0.5 mL/min, the mass of the collected eluent 
should be 0.5 ± 0.02 g.

d. If necessary, adjust the flow rate knob, and then repeat Steps b and c. 
Continue adjusting until the desired mass per minute is collected.

e. Reconnect the ELUENT IN line to the suppressor.
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B.14.1 Record the Measured Flow Rate in Chromeleon.

1. From the Control panel, press the F8 button or select 
Control>Command.

2. Expand the Pump_ECD group and select MeasuredFlowRate (see 
Figure B-23).

Figure B-23. ICS-90 Chromeleon Commands: MeasuredFlowRate

3. Enter the flow rate and click Execute. Click Close. The measured 
flow rate is now shown on the Control panel.
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B.15 Equilibrating the System

1. After priming the pump and adjusting the flow rate, leave the pump on and 
flush the system for about 5 minutes to equilibrate.

2. Monitor the system pressure from the Control panel to make sure the pressure 
is between 107 and 153 MPa (1600 and 2300 psi). If the pressure is less than 
107 MPa (1600 psi), gas may be trapped in the system. Release the gas by 
opening one fitting at a time from the pump head and along the plumbing to 
the column; pay close attention to the line from the pulse damper (see 
Figure B-21).

3. Check that there are no leaks in the regenerant reservoir.

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 µS for a system 
set up for anion analyses, and <2 µS for a system set up for cation analyses.

B.16 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure. Record the short-term pressure fluctuations; they 
should be less than 0.13 MPa (20 psi).
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B.17 Connecting the AS40 Automated Sampler (Optional)

1. Open the front door of the ICS-90 and thread the outlet line from the AS40 
through the side slot near the lower ICS-90 door hinge (see Figure B-20).

2. Connect the outlet line from the AS40 to port S (5) of the injection valve (see 
Figure B-24). 

3. Follow the steps below to connect the TTL Output connector on the ICS-90 
rear panel to the RELAY CONTROL connector on the AS40 rear panel.

a. Locate the Relay Control cable (P/N 047946) supplied with the AS40. 

b. Connect the Relay Control cable's 10-pin connector to the RELAY 
CONTROL connector on the AS40 rear panel (see Figure B-25).

c. Plug the 2-pin connector from the pair of wires labeled LOAD on the 
Relay Control cable into the TTL Output connector on the ICS-90.

Figure B-24. Injection Valve Connections

Figure B-25. AS40 Autosampler Connection
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B.18 Operating the ICS-90

ICS-90 installation is complete. For routine operation, refer to Section 3.5.

B.19 Installation Troubleshooting

Problem: When the ICS-90 power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon was installed.

Solution: 

1. Click the Cancel button in the Windows message box. 

2. Turn off the ICS-90 power and unplug the USB cable from the computer.

3. Install Chromeleon (see Section B.3).

4. Reconnect the USB cable to the computer and turn on the ICS-90 power. 
Windows will now automatically recognize the new ICS-90. 
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C • Reordering Information

Part Number Item

Pump

057853 Pump head assembly

055870 Main piston seal

036901 Backup piston seal

035776 O-ring

047661 Outlet check valve assembly, 10-32

047660 Inlet check valve assembly, 1/4-28

057233 Backup washer assembly

035030 Piston guide

036904 Piston

035014 Piston return spring

035595 Piston spring guide

035885 Washer (installed under acorn nut on pump head assembly)

036884 Acorn nut (secures the pump head to the pump housing)

Sample Loop and Injection Valve

042949 10 µL sample loop assembly

057896 Injection valve rebuild kit

024305 Luer adapter fitting, 1/4-28 (for manual injections)
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Reagent Reservoir Assemblies

057711 Eluent reservoir assembly (includes stopper and cap)

057712 Anion regenerant reservoir assembly (includes stopper and cap)

057713 Cation regenerant reservoir assembly (includes stopper and cap)

059068 O-ring for eluent or regenerant reservoir stopper

Reagents

057559 Anion Regenerant Concentrate (75 mL of 2.0 N sulfuric acid)

057555 4-Pack of Anion Regenerant Concentrate

057561 Cation Regenerant Concentrate (100 mL of 2.06 M TBAOH)

057556 4-Pack of Cation Regenerant Concentrate

Suppressors and Cell

056751 AMMS III suppressor

056753 CMMS III suppressor

057290T DS5 Detection Stabilizer

Part Number Item
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D • FAQ

D.1 How do I hook up an AS40 Automated Sampler?

For instructions on how to connect the ICS-90 to an AS40, see Section B.17 of 
this manual. Also see the AS40 Automated Sampler Operator’s Manual 
(Document No. 034970).

D.2 How do I print?

Click the Print toolbar button in Chromeleon (see Section 2.3.2).

D.3 How often should I perform calibrations?

Recalibrate every six months or after changing a major component (separator 
column, DS5, suppressor, etc.).

D.4 Why are the retention times moving?

Retention times can shift if the pump flow is erratic or if the column or eluent is 
contaminated. See Section 4.6 for pump flow rate troubleshooting. If a 
contaminated column is suspected, clean the column as instructed in the column 
manual. The column manual is included on the Dionex Reference Library CD-
ROM (P/N 055405), located in the ICS-90 Ship Kit.

D.5 How do I adjust retention times?

Retention times are calculated during calibration. The Use Recently Detected 
Retention Time parameter in the Chromeleon QNT Editor (General tab) can be 
used to compensate for some types of retention time drifts; for example, 
evaporation of volatile components in pre-mixed solvents or an aging column. 
Refer to the Chromeleon Help or user’s guide for details.
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D.6 When should I remake standards?

Standards are used only for calibration and should always be made fresh (they 
have a lifetime of only one week).

D.7 When should I remake eluents?

Eluents should be remade every two or three weeks.

D.8 How do I start Chromeleon?

Click Start on the Windows taskbar, and then select Programs>Chromeleon > 
Chromeleon.

D.9 How do I delete data?

In the Chromeleon Browser, highlight the sequence you want to delete and then 
select File>Delete.

D.10 How do I back up data?

In Chromeleon, select File>Export/Backup. Back up the data and indicate the 
backup source. 

D.11 How do I shut off the system?

In Chromeleon, turn off the pump from the ICS-90 Control panel (see 
Figure 2-10). On the ICS-90, turn off the power switch on the rear panel (see 
Figure 2-2).

D.12 How do I store columns?

Columns should be stored in eluent. See the column manual for complete 
instructions. The column manual is included on the Dionex Reference Library 
CD-ROM (P/N 055405), located in the ICS-90 Ship Kit.
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D.13 How do I know when a column is dirty?

See the troubleshooting section of the column manual. The column manual is 
included on the Dionex Reference Library CD-ROM (P/N 055405), located in the 
ICS-90 Ship Kit.

D.14 How do I clean a column?

See the troubleshooting section of the column manual. The column manual is 
included on the Dionex Reference Library CD-ROM (P/N 055405), located in the 
ICS-90 Ship Kit.

D.15 Why is the conductivity high?

Possible reasons for high conductivity include:

• The suppressor needs regeneration. See the suppressor manual for 
troubleshooting information. The suppressor manual is included on the 
Dionex Reference Library CD-ROM (P/N 055405), located in the ICS-90 
Ship Kit.

• The regenerant is exhausted and should be remade. See Section 3.2 for 
instructions on preparing regenerant.

• The DS5 is out of calibration. See Section 5.1.2 for calibration instructions.
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E • Glossary

Analytical Column
Synonymous with Separator Column.

Band Spreading
The broadening of the sample band as it travels through the column. Band 
spreading can also occur in the injection valve, detector cell, and interconnecting 
tubing.

Calibration Curve
A graph showing detector response in peak height or area versus analyte 
concentration.

Capacity Factor (k´)
The number of column volumes of eluent, pumped through the column, required 
to elute an analyte. Capacity factor is a dimensionless measure of retention which 
is independent of column length or eluent flow rate. It is calculated as follows: 

Where: tr = retention time
to = retention time of unretained solute (column void volume)

Cell Constant (k)
A factor determined experimentally by measuring the conductance (G) of a 
standard solution of known equivalent conductivity (k).

k′
tr to–

to
--------------=

k κ G⁄=
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The value of k depends upon the surface area of, and distance between, the 
electrode faces in the conductivity detector cell.

Where: l = length
A = area of one electrode (the other electrode is equal to
the first)

Channeling
The preferential flow of liquid along more open, less resistant paths through the 
column packing. This causes Band Spreading.

Column Efficiency (N)
A measure of the narrowness of analyte bands as they elute from the column. 
High efficiency is desirable because resolution between closely spaced bands 
improves with greater efficiency. For a symmetrical (Gaussian) peak, column 
efficiency can be determined by the following:

N = 5.54(t1/W1/2)2

Where:  t1 = the peak retention time, in seconds
W1/2 = the peak width at 1/2 height, in seconds

Column efficiency is proportional to column length: for a given resin and column 
diameter, increasing the column length increases the column efficiency. 
Synonymous with Theoretical Plates.

Column Selectivity (a)
Describes the relative separation of the band maxima between two adjacent peaks. 
Selectivity can be determined by the following:

a = (t2 - t0)/(t1 -t0)

Where: t1 and t2 = retention time of components 1 and 2, respectively
t0 = retention time of unretained components (void volume)

Concentrator Column
A short column used to retain and concentrate analytes from a measured volume 
of relatively clean sample. This allows large volumes of sample to be injected, 
lowering concentration detection limits.

Conductivity
A measure of the ease with which electrical current flows through a liquid 

k l A⁄=
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contained between two opposite charged electrodes. Conductivity is a 
characteristic of ions in solution. Units are siemens.

Counterion
Ions carrying a charge opposite that of the sample ions (e.g., Na+) may be the 
counterion of a Cl- analyte. These ions preserve electrical neutrality in solution.

% Crosslink
Divinylbenzene content in a polystyrene/divinylbenzene (PS-DVB) resin; this 
contributes to the mechanical strength of the resin and determines 
chromatographic properties.

Electrical Conductance

Equivalent Conductivity (λ)
The contribution of an ionic species to the total conductivity of a solution as 
measured in a standard cell having electrodes 1 cm2 in area and exactly 1 cm 
apart.

Guard Column
A small column that prevents poisoning of the separator column by sorbing 
organic contaminants and removing particulates. It is filled with the same packing 
as the separator column. Synonymous with Pre-Column.

HETP (H)
Height Equivalent to a Theoretical Plate. A measure of column efficiency which 
allows comparison between columns of different lengths.

HETP = H = L/N

Where: L = the column length (mm)
N = the number of theoretical plates

Ion-Exchange Capacity
The number of active ion exchange sites in a given weight or volume of resin; this 
is usually expressed in meq/g or meq/mL.

Ion-Exchange Resin
An insoluble polymer matrix containing fixed-charge exchange sites (anionic or 
cationic). IC resins are formed into small spherical particles (beads).

Packing
The material that fills a chromatographic column; usually a resin or silica-based 
material.
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Pellicular Resin
A resin with a solid, nonporous core coated with a thin layer of more porous 
material. The exchange sites of pellicular ion exchange resins are located only on 
the surface layer of the bead. These resins have a low ion-exchange capacity.

Pre-Column
Synonymous with Guard Column.

Regenerant
A dilute acid or base which converts ion exchange sites in the suppressor back to 
the form which will suppress the eluent conductivity.

Resin
See Ion-Exchange Resin.

Resolution (R)
A measure of the separation between two sample components. It is expressed as 
the ratio of the distance between the two peak maxima to the mean value of the 
peak width at the baseline.

R = 2(t2 - t1)/(W2 + W1)

Where: t1 and t2 =the retention times of components 1 and 2,
respectively
W1 and W1 = the baseline width of peaks 1 and 2,
respectively (measured in the same units as the retention
time)

R is proportional to the square root of efficiency (N). A value of R = 1.5 
represents “baseline separation” of the two peaks.

Retention Time
The time from injection to peak maximum; the basis for identification of a species 
in chromatographic analysis.

Separator Column
The column used to perform a chromatographic separations; also called analytical 
column.

Siemens (S)
Unit measure of conductance; the reciprocal of the electrical resistance of a 
solution.
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Suppressor
A device used to minimize eluent conductivity and convert sample species to a 
common form, thus increasing detection sensitivity.

Temperature Coefficient
The percent of change in the conductivity of a solution with a 1 oC change in 
temperature. Every solution has a characteristic temperature coefficient which is 
determined experimentally. 

Theoretical Plates (N)
See Column Efficiency.

Void Volume (V0)
The volume occupied by the eluent in a packed column. This volume includes the 
volume between the injection valve and the column, as well as between the 
column and the detector cell. Unretained components are eluted in the void 
volume.
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Index

A
Air particulate samples, 3-4
Air regulator, 3-2, B-20, B-26
Alarm conditions, 4-1
Alarms

Load/inject valve error, 4-2 – 4-3
Over conductivity alarm, 4-2
Pump over pressure alarm, 4-1
Pump under pressure alarm, 4-2

Ambient temperature, 4-10
Analytical column, 2-11

See also Columns
Anion regenerant, 2-3
AS40 Automated Sampler

Installation, B-34
Sample injection, 3-12
TTL output connector, 2-6

Audit Trail, 2-17, 5-2
Auto offset requirements, A-4
Autozero, 2-17, 3-8

B
Background conductivity

High, 4-3, 4-9
Offsetting, 3-7, 3-10

Backpressure
Restriction in plumbing, 5-10
Troubleshooting, 4-6

Backpressure coils, B-23, B-25
Baseline drift, 4-10
Baseline noise, 2-12, 4-10
Blockages

Liquid lines, 4-1, 5-10
Browser, 2-15

C
Cables

Power cord, 5-21
USB, B-6

Calibration, 5-1
Downloading factory calibrations, 5-3
DS5, 5-3
Pressure transducer, 5-3

Carbonate eluent, 2-3
Cation eluent, 2-3
Cation regenerant, 2-3
Caution icon, 1-5 – 1-6
Cell

See DS5 Detection Stabilizer
Cell calibration, 5-6
Check valves

Cleaning and replacing, 5-10
Chromeleon

Alarm conditions, 4-1
Browser, 2-15
Communication with ICS-90, 2-5
Error conditions, 4-1
ICS-90 Control panel, 2-15, 3-8
Interface, 2-15
License, B-10
Menu, 2-15, 3-8
Toolbars, 2-15, 3-8
Wellness panel, 5-1

Chromeleon setup, B-10
Columns

Cleaning, D-3
Contaminated, 4-8
Guard, 2-11
Installing, B-23
Separator, 2-11
Storing, D-2

Commands, 2-15, 3-9
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Component mounting panel, 2-7
Columns, 2-11
DS5 Detection Stabilizer, 2-7
MMS III suppressor, 2-9
Pressure transducer, 2-9
Prime valve, 2-11
Pump, 2-11

Computer
Connecting to the ICS-90, B-6
Unpacking, B-4

Conductivity, 2-17
Causes of high conductivity, D-3
Selecting the range, B-14
Temperature effect, 2-8

Conductivity cell, 2-7
See also DS5 Detection Stabilizer

Control panel
See ICS-90 Control panel (Chromeleon)

D
Danger icon, 1-5 – 1-6
Data

Backing up, D-2
Deleting, D-2

DCR
See Displacement chemical regeneration

Decibel level, A-1
Delay volume specifications

System total, A-4
Detector specifications

Auto offset, A-4
Cell drive, A-4
Control and data evaluation, A-4
Linearity, A-4
Range, A-4, B-14
Temperature compensation, A-4

Diagnostics, 5-1, 5-3
Dimensions, A-1
Displacement chemical regeneration, 2-13
Dongle, B-8, B-10
DS5 Detection Stabilizer, 2-7

Calibrating, 5-6

High cell output, 4-9
No response, 4-9
Replacing, 5-19

DS5 Detection Stabilizer specifications
Active volume, A-4
Cell body, A-4
Electrodes, A-4
Maximum pressure, A-4

Dummy cell, 4-9, 5-3

E
ECD

See Electrochemical detector conductivity
Elapsed time, 2-17
Electrical specifications

Fuses, A-1
Main power, A-1

Electrochemical detector conductivity, 5-2, 
B-13

See also Conductivity
Eluent, 2-3

Delivery process, 1-1
Preparing, 3-1
Pressurizing the reservoir, 3-2
When to remake, D-2

Eluent reservoir, 2-3
Pressurization, 3-2, B-26

Environmental specifications
Gas pressure, A-2
Humidity, A-2
Operating pressure, A-2
Operating temperature, A-2

Equilibration time, 3-7
Error conditions, 4-1

F
Facility requirements, B-1
Fittings

Leaking, 4-4
Replacing, 5-8
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Requirements, 5-8
Flow path, 2-12
Flow rate, 2-11, A-3

Setting, B-29
Troubleshooting, 4-6

Fluid schematic, 2-12
Front panel, 2-2
Fuses

Changing, 5-21
Requirements, A-1

G
Gas source

Installation, B-20, B-23
Pressure requirements, A-2, B-20

Ghosting, 4-7
Guard column, 2-11, B-23

H
High pressure alarm, 4-2
Hub (USB), B-7 – B-8
Humidity limits, A-2

I
Icons used in manual, 1-5
ICS-90

Component mounting panel, 2-7
Flow path for system, 2-12
Flow rate, A-3
Front panel, 2-2
Rear panel, 2-4
Top cover, 2-2
Weight, B-2

ICS-90 Control panel (Chromeleon), 2-15, 3-8
Important icon, 1-5
Injecting sample

Syringe injection, 3-10
Vacuum syringe technique, 3-11
Via the AS40, 3-12

Injection events, 3-10
Injection port, 2-2
Injection valve, 2-10

Automatic reset, 3-10
Leaking, 4-5
Rebuilding, 5-18
Specifications, A-4

Installation
AS40 autosampler, B-34
Columns, B-23
Connecting to the computer, B-6
Gas source, B-20, B-23
Operational status verification, B-33
Power connection, B-8
Priming the pump, B-27, B-33
Setting up Chromeleon, B-10
Setting up the eluent and regenerant, B-21
Starting the ICS-90, B-9
Suppressor, B-25

Ion chromatography overview, 1-1
Ion exchange, 1-1
Isocratic delivery system, 1-1

L
Leaks

Fittings, 4-4
Injection valve, 4-5
Liquid, 4-4
Pressure transducer, 4-4
Pump head waste valve, 4-4
Suppressor, 4-5

LEDs
Link, 2-5
Status, 2-2

License (Chromeleon), B-10
Lifting the ICS-90, B-2
Line frequency, B-8
Linearity requirements, A-4
Link LED, 2-5, A-3
Liquid leaks, 4-4
Load/inject valve alarm, 4-2 – 4-3
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Loop, 2-10
Changing, 5-9

M
Main power receptacle, 2-5
Maintenance, 3-13

Daily, 3-13
Ongoing, 3-13
Weekly, 3-13
Yearly, 3-13

Messages
Safety, 1-5

Methanesulfonic acid eluent, 2-3
MMS III suppressor, 2-9

Displacement chemical regeneration, 2-13
Installing, B-23
Leaking, 4-5

N
Nitrite in samples, 3-4

O
Operating features, 2-1 – 2-2
Operating pressure, A-2
Operating temperature, A-2
Operation

Equilibration time, 3-7
Injecting sample, 3-10
Post-injection events, 3-10
Start-up procedure, 3-5

Over conductivity alarm, 4-2

P
Panels

Chromeleon Control panel, 2-15, 3-8
Chromeleon Wellness panel, 5-1
Component mounting panel, 2-7

Front panel, 2-2
Rear panel, 2-4

Parameters, 2-15, 3-9
Peak ghosting, 4-7
Peak height

Troubleshooting, 4-8
PEEK cell body, 2-7
Physical specifications

Decibel level, A-1
Dimensions, A-1
Weight, A-1

Piston seal
Replacing, 5-12

Power cord, 5-21
Power receptacle, 2-5
Power requirements, A-1
Power switch, 2-4
Power-up conditions, 3-5
Pressure

Limit, 4-2
System, 4-1 – 4-2, 5-2

Pressure requirements
Gas source, A-2

Pressure transducer, 2-9
Leaking, 4-4

Prime valve, 2-11
Priming procedure, B-27, B-33
Printing, D-1
Program time, 2-17
Pulse damper, 2-12

Specifications, A-3
Pump, 2-11

Cleaning and replacing check valves, 5-10
Flow rate, 2-11, B-29
Flow reduction, 3-8
Over pressure alarm, 4-1
Piston replacement, 5-15
Piston seal replacement, 5-12
Priming problems, 4-5
Priming procedure, B-27, B-33
Pump head assembly, 5-11
Replacing the waste valve O-ring, 5-17
Troubleshooting, 4-6
Under pressure alarm, 4-2
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Pump head waste valve
Leaking, 4-4

Pump specifications
Flow rate, A-3
Operating pressure, A-3
Operation mode, A-3
Type, A-3

R
Rear panel, 2-4

Link LED, 2-5, A-3
Power receptacle, 2-5
Power switch, 2-4
TTL output connector, 2-6
Tubing connections, 2-6
USB receptacle, 2-5

Rebuilding the injection valve, 5-18
Recalibration (when to perform), D-1

See also Calibration
Regenerant, 2-3

Acid concentrates, 3-1, B-21
Filling the reservoir, 3-2, B-21
Preparation, 3-1 – 3-2, B-21
Preparing, 3-1
Shaking the contents, 3-2, B-21

Regenerant reservoir, 2-3
Reordering information, C-1
Replacing a pump piston, 5-15
Replacing the DS5 Detection Stabilizer, 5-19
Replacing tubing and fittings, 5-8
Reservoirs, 2-3
Restriction in plumbing, 5-10
Retention time

Adjusting, D-1
Moving, D-1
Troubleshooting, 4-8

Rheodyne valve, 2-10
Run time, 2-17

S
Safety labels, 1-7
Safety messages and icons, 1-5 – 1-6
Sample injection

AS40 injection, 3-12
Via syringe, 3-10
Via vacuum syringe, 3-11

Sample loop, 2-10
Changing, 5-9
Injecting, 2-10
Injection valve connections, 5-9
Loading, 2-10

Samples
Collecting and storing, 3-4
Diluting, 3-4
Filtering, 3-4
Injecting, 3-10
Preparing, 3-4
Pretreating, 3-4

Schematic
Fluid, 2-12

Selectivity
Troubleshooting, 4-8

Separator column, 2-11, B-23
Server Configuration program, B-11
Server Monitor, B-10
Service, 5-19

Changing fuses, 5-21
Changing the sample loop, 5-9
Cleaning and replacing pump check 

valves, 5-10
Pump piston replacement, 5-15
Pump piston seal replacement, 5-12
Rebuilding the injection valve, 5-18
Replacing the suppressor, 5-21
Replacing the waste valve O-ring, 5-17
Replacing tubing and fittings, 5-8
Restriction in liquid lines, 4-1, 5-10

Shipping screw
Pump, B-3

Software license, B-10
Specifications

Delay volume, A-4
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Detector, A-4
DS5 Detection Stabilizer, A-4
Electrical, A-1
Environmental, A-2
Injection valve, A-4
Physical, A-1
Pump, A-3

Standards
When to remake, D-2

Standby mode, 3-8
Start-up conditions, 3-5
Start-up procedure

Chromeleon, 3-6
ICS-90, 3-5

Status LEDs, 2-2
Sulfite in samples, 3-4
Sulfuric acid regenerant, 2-3
Suppressor, 2-9

Off-line regeneration procedure, 4-3
QuickStart procedure, 4-3
Replacing, 5-21

Symbols, 1-7
Syringe injection, 3-10
System

Shutdown, D-2
System status, 5-2

T
TBAOH, 2-3
Temperature

Compensating, 2-8
Control, 2-8
Minimizing the effect of variations, 2-8

Tetrabutylammonium hydroxide regenerant, 
2-3
Time, 2-17
Timebase, B-12
Top cover, 2-2
Troubleshooting

Alarm conditions, 4-1
Calibrations, 5-1
Diagnostics, 5-1

Error conditions, 4-1
Excessive backpressure, 4-6
Flow rate, 4-6
High DS5 output, 4-9
Liquid leaks, 4-4
No DS5 response, 4-9
Peak ghosting, 4-7
Peak height, 4-8
Pump, 4-5
Retention time, 4-8
Selectivity, 4-8
System status, 5-2

TTL output connector, 2-6
Tubing

Replacing, 5-8
Requirements, 5-8

Tubing connections, 2-6
Isolating a restriction, 4-1, 5-10

U
Unpacking, B-2

Computer, B-4
ICS-90, B-2
Removing the shipping screw, B-3

USB
Cable connection, B-6
Cable specifications, B-8
Connecting to a hub, B-7

USB hub, B-8
USB receptacle, 2-5

V
Vacuum syringe injection, 3-11

W
Warning icon, 1-5 – 1-6
Waste lines

Blocked, 4-4
Connection, B-19
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Waste valve O-ring
Replacing, 5-17

Water samples, 3-4
Weight, A-1
Wellness panel, 5-1

Audit Trail, 5-2
Calibrations, 5-3
Diagnostics, 5-3
Dummy cell, 5-3
ECD conductivity, 5-2
System pressure, 5-2
System status, 5-2

Z
Zeroing the baseline

At injection, 3-10
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